VIP ContentExplorer

User Guide

Please read this guide carefully. For more information about OpenText products, contact your OpenText representative or refer to the documentation delivered with your VIP DocManager product.
Contents

Chapter 1
How to Use This Guide
How This Guide is Organized

Chapter 2
VIP ContentExplorer Overview
VIP ContentExplorer Functions
Viewing DocFolders, DocLinks, and OmniLinks
Viewing Workflow Items
VIP ContentExplorer Features
Comparing VIP ContentExplorer Platforms
VIP ContentExplorer Operating Requirements

Chapter 3
Getting Started with VIP ContentExplorer
Configuring Internet Explorer Settings
Logging into VIP ContentExplorer
Selecting the Display Language
The VIP ContentExplorer Workspace
Tree Control Pane
Navigating the Tree Control Pane
Content Frame Pane
Toolbar Buttons
Exiting VIP ContentExplorer
# Table of Contents

## Chapter 4
### Accessing Content
- Accessing Content via DocFolders ................................................................. 23
- Accessing Content via DocLinks ........................................................................ 24
  - The DocLink Concept ......................................................................................... 27
  - A Case Study Using DocLinks ........................................................................... 28
  - Using DocLinks to Find Content ....................................................................... 28
    - Saving Queries .................................................................................................. 32
  - The User Column Editor ..................................................................................... 33
  - Using DocLinks to Capture a Content Object .................................................. 35
  - Editing DocLink Values ...................................................................................... 36
  - Copying DocLink Values .................................................................................... 36
  - Deleting DocLink Values ................................................................................... 37
- Accessing Content via OmniLinks ....................................................................... 38
  - The OmniLinks Concept ..................................................................................... 38
  - A Case Study Using OmniLinks .......................................................................... 38
  - Using OmniLinks to Find Content .................................................................... 39

## Chapter 5
### Working with Workflow Items
- Finding and Opening Work Items ...................................................................... 45
  - Selecting Columns and Sorting the Item List .................................................... 46
  - Searching for Work Items .................................................................................. 49
- Working With Work Items .................................................................................... 50
  - The Work Item Window ..................................................................................... 50
  - Processing Work Items ...................................................................................... 52
- Starting a New Work Case ..................................................................................... 53
- Working with Captaris Workflow ......................................................................... 54

## Chapter 6
### Revision Control
- Document Revision Overview ............................................................................. 66
  - The Revision Control Process .......................................................................... 56
  - Revision Control Tips ....................................................................................... 57
- Initial Check In ....................................................................................................... 58
- Checking Out a Document .................................................................................... 59
  - Modifying a Document ...................................................................................... 61
- Checking In a Document ....................................................................................... 62
- Adding Annotations as Revisions ....................................................................... 64
- Viewing Document Revisions .............................................................................. 65
- Reverting to a Previous Document Revision ...................................................... 66
- Protecting Documents .......................................................................................... 67
Chapter 7
The VIP ContentViewer ................................................................. 69
   VIP ContentViewer Overview....................................................... 70
   The VIP ContentViewer Workspace............................................... 71
   VIP ContentViewer Menus............................................................ 72
   VIP ContentViewer Toolbar......................................................... 75
   Comparing Documents .............................................................. 78
   Changing the Mouse Mode .......................................................... 79
   Moving Through the Document .................................................. 80
   Changing the Document Display .................................................. 81
      Zooming the Document Display ................................................ 81
         Rubberband Zooming ......................................................... 81
         Mouse Zooming ............................................................... 81
         Fixed Magnification Zooming .............................................. 81
      Rotating an Image ................................................................. 82
   Image Processing ........................................................................ 83
   Changing AFP Document Resolution ......................................... 83
   Working with Color .................................................................... 83
   Opening Images in Another Viewer ............................................ 85
   Report Sequential Search ........................................................... 86
   Report Index Search ................................................................... 88
   The Mobile Device Document Viewer ......................................... 89

Chapter 8
Notes and Annotations ................................................................. 91
   Notes and Annotations Overview................................................ 92
      Notes and Annotations on Mobile Devices ............................... 92
      Text Notes............................................................................... 93
      Working with Text Notes........................................................ 93
   Annotations.................................................................................. 96
      Showing and Hiding Annotations ............................................. 96
      Selecting Annotation Display Colors ..................................... 97
   Bookmarks ................................................................................... 97
      Defining Bookmarks ............................................................... 97
      Going to a Bookmark ............................................................. 98
   Saving Annotations ..................................................................... 98
   Printing Annotations ................................................................... 99
   Individual Annotations ................................................................ 99
      Blackout Annotations ............................................................. 100
      Highlight Annotations .......................................................... 101
      Sticky Notes........................................................................... 102
      Attach File............................................................................. 104
      Rubber Stamp ........................................................................ 104
Chapter 1

How to Use This Guide

The *VIP ContentExplorer User Guide* describes how to use the VIP ContentExplorer application. VIP Content Explorer lets you retrieve, view, and work with images and reports stored on a VIP DocManager server, and process workflow cases stored on a VIP WorkflowManager server.

This guide assumes you are familiar with Windows standards and web application user interfaces. It is intended for System Administrators and users who need a description of VIP ContentExplorer and its user interface.
How to Use This Guide

How This Guide is Organized

This guide provides an overview of the VIP ContentExplorer application. It includes the following chapters and appendices:

Chapter 1: An overview of this guide
Chapter 2: An overview of VIP ContentExplorer
Chapter 3: How to log into and out of VIP ContentExplorer, and a description of the workspace and user interface
Chapter 4: How to find and select documents on a VIP DocManager server through DocClasses, DocLinks, or OmniLinks
Chapter 5: How to find and work with workflow items stored on a VIP WorkflowManager server
Chapter 6: How to use revision control
Chapter 7: How to use the VIP ContentViewer to view reports and images
Chapter 8: How to add and work with text notes and other types of annotations
Chapter 9: How to print or e-mail documents or save them as external files
Chapter 10: How to display audit logs
Appendix A: How to adjust Java Plug-in memory sizes for best VIP ContentExplorer performance
Appendix B: How to contact Open Text technical support
Chapter 2

VIP ContentExplorer Overview

VIP ContentExplorer is an HTML-based client that lets you access documents (images and reports) archived on the VIP DocManager server and active cases on the VIP WorkflowManager server.

This chapter discusses:

- VIP ContentExplorer Functions (see page 4).
- VIP ContentExplorer Features (see page 5).
- VIP ContentExplorer Operating Requirements (see page 7).
VIP ContentExplorer Functions

VIP ContentExplorer unifies portal and Web content management capabilities with document management and enterprise workflow. VIP ContentExplorer lets you use your Web browser to view VIP DocManager DocFolders, DocLinks, OmniLinks, and Workflow cases, and contains a ContentViewer to display images and reports from the server.

Viewing DocFolders, DocLinks, and OmniLinks

VIP ContentExplorer lets you use the DocFolders, DocLinks, and OmniLinks defined on the VIP DocManager server to find and display any archived document. You can then add notes to the document, print it, e-mail it to other users, and so on. VIP ContentExplorer is similar to the VIP DocView Windows client.

Viewing Workflow Items

VIP WorkflowManager is a workflow management system that allows documents to be routed through predefined steps as part of a workflow process.

VIP WorkflowManager activities are based on the following concepts:

- A **procedure** is a sequence of steps that comprise a business process, such as invoice approval or claims processing. The procedure determines how each step is routed from user to user to accomplish the business process.

  The VIP WorkflowManager Administrator defines procedures on the VIP WorkflowManager server.

- A **step** is a specific function within a procedure. Each step is associated with:
  - a **user** who completes the step,
  - a **form** filled in by the user, and
  - an **action** taken after the user completes the form. If more than one action is possible, the user selects the action on the form.

  Steps are defined on the VIP WorkflowManager server by the VIP WorkflowManager Administrator.

- A **case** is a specific instance of a procedure, such as the approval of Invoice #1234.

- A **work queue** holds cases which have been assigned to a particular user or user group for the current step.

When a case is initiated on the VIP WorkflowManager server, it is assigned to the work queue for the users who can perform its first step. When a user completes the step, he or she releases the case and it is assigned to the work queue for the next step in the workflow process. After all steps are completed, the case is closed.

VIP ContentExplorer enables you to view work queues you belong to, retrieve cases and their associated documents from the queues, and complete the forms required for each step.
VIP ContentExplorer Features

VIP ContentExplorer provides a paperless workflow system that simplifies electronic document retrieval. VIP ContentExplorer does this through the following features:

- User-friendly interface
- Standardized data entry
- Security

User Friendly Interface

VIP ContentExplorer provides a web-based user interface. In most cases, you use the mouse or keyboard to select items in the same way as most other web applications: clicking a filename to open or select a file, for example.

Standardized Data Entry

When using the workflow application, VIP ContentExplorer provides an intelligent form for entering comments and setting field values to determine what happens next in the workflow process. The form is transferred from one user to another user (or group of users) for further processing.

Security

VIP ContentExplorer application provides security based on user permissions defined on the VIP DocManager server. This means that you may be able to open some documents and not others, or perform some operations with a document, such as viewing it and adding annotations, but not others, such as printing or emailing.

Comparing VIP ContentExplorer Platforms

You can use VIP ContentExplorer from three different device types:

- A workstation—a desktop or laptop computer
- A supported tablet computer
- A supported smart phone

Due to the differences in software and hardware compatibility, VIP ContentExplorer uses a different document viewer on tablet computers and phones than it does on workstations. In addition, some features are available only on certain devices, as described in this table:

<table>
<thead>
<tr>
<th>Feature</th>
<th>PC</th>
<th>Tablet</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>View reports and images</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Search for documents using DocLinks or OmniLinks</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sort search results (hit list) by any column</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>List documents by folder</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
This manual describes how to use VIP ContentExplorer on workstations and tablet computers. For instructions on using it on a smart phone, see the help file available in the product when used on a phone.

**Note**  This manual sometimes refers to tablet computers and phones together as “mobile devices.”
VIP ContentExplorer Operating Requirements

Please see the *Release Notes* for operating requirements.
Chapter 3

Getting Started with VIP ContentExplorer

After the VIP ContentExplorer Suite is installed, you can begin using it to view content and process workflow cases. This chapter discusses:

- Configuring Internet Explorer to work with VIP ContentExplorer (see page 10)
- Logging into VIP ContentExplorer (see page 12)
- Navigating through the VIP ContentExplorer workspace (see page 15).
- Exiting from VIP ContentExplorer (see page 22).
Configuring Internet Explorer Settings

If you use Microsoft Internet Explorer, you need to check, and possibly change, some browser settings before using VIP ContentExplorer for the first time. This section describes how to configure these settings.

**Note** These instructions are for Internet Explorer 8. The steps may be different for other versions.

1. Launch Internet Explorer.
2. From the Tools menu, select **Internet Options** to display the **Internet Options** dialog box.
3. On the **General** tab page, in the **Browsing History** area, click **Settings**.
4. In the **Temporary Internet Files and History Settings** dialog box, select **Every time I visit the Web page**.
5. Click **OK**.
6. On the **General** tab page, click **Delete** to clear your browser history.
7. Click the Advanced tab.

8. Make sure the Disable script debugging (Internet Explorer) and Disable script debugging (Other) options are checked.

9. Scroll down the list of settings to the Java (Oracle) settings. Check the Use JRE v 1.x for <applet> box. x varies depending on what version of the Java Plug-in is installed.

10. The browser should allow cookies for the Web site where VIP ContentExplorer is hosted. The easiest way to ensure this is to add the Web site to the list of trusted sites:
    - Click the Security tab.
    - Click Trusted Sites.
    - Click Sites.
    - Type the URL you use to access ContentExplorer and click Add.
    - Click Close.

11. Click OK to close the Internet Options dialog box.

12. Close all browser instances, and restart Internet Explorer.
Logging into VIP ContentExplorer

To use VIP ContentExplorer, you must log in to the VIP DocManager server that contains the information you want to work with. You do this by selecting the server and entering your user name and password.

If your installation uses the optional VIP WorkflowManager, in most cases you will log in to both a VIP DocManager server and an associated VIP WorkflowManager server. Depending on how your Administrator has configured VIP ContentExplorer, you may be logged into both servers based on a single user name and password, or you may have to login separately, as described in the procedure below.

**Tip**
In most instances, the login criteria resembles the dialog box shown below. The login for iSeries servers may also contain an account number, a Social Security number, and other login criteria.

To log into VIP ContentExplorer

1. In your Web browser, point to the URL for VIP ContentExplorer. This is usually `http://<server>/contentexplorer`. On a tablet computer, the URL is `http://<server>/contentexplorer/tcoex.jsp`. On a smart phone, the URL is `http://<server>/contentexplorer/icoex.jsp`. For further instructions about using ContentExplorer on a smart phone, please see the help file available in the phone application.

   **Tip** On either a tablet or a smart phone, you can create an icon for ContentExplorer on your home page by following the instructions for your browser.

2. In the Tree Control (see page 15), click the server to log in to. If you have not previously logged in to this server and checked **Remember my ID**, the Login dialog box opens.

   ![Login to the Document Manager Server](image)

   **Tip** If you have checked **Remember my ID** for this server, you see the VIP ContentExplorer main window. See page 15 for more information. To log in as
a different user, click **Click here to login as a different user** to open the login
dialog box.

**Note** You will also see the *Login* dialog box if you have previously checked
*Remember my ID*, but your password for the server has changed.

3. Type your **Username** and **Password**.

**Tip** For an iSeries DocManager server, if your password has expired, you see the
change password dialog box, where you can create a new password. If you
have checked *Remember my ID*, ContentExplorer updates your saved
password, so you will not have to enter it again the next time you log in.

4. For Windows and UNIX servers, type the name of the **Domain** for your user name.

5. If you want VIP ContentExplorer to remember your login information so you don’t
have to re-enter it next time, check the *Remember my ID* box.

6. Click **Submit** to log into the VIP DocManager server.

7. Depending on how your Administrator has configured VIP ContentExplorer, you
may see another *Login* window, where you can log in to the VIP WorkflowManager
server associated with the VIP DocManager server. If so, repeat steps 3 through 6,
using the correct login information for the VIP WorkflowManager server.

If you see the *Login to Workflow Manager* dialog box but don’t want to log in to VIP
WorkflowManager, click **Skip current server**.

After login, you see the VIP ContentExplorer main window. See page 15 for more
information on the main window.

**Note** If your installation is set to log you into the VIP WorkflowManager server
automatically, but that login fails after the VIP DocManager login succeeds,
you see the *Login to WorkflowManager* dialog box. Continue as described in
step 7, above.

**Note** If you click **Skip current server** on the *Login to the Document Manager Server*
dialog box, you can log in to the VIP WorkflowManager server without
logging into the VIP DocManager server. If you do this, you will be able to
view workflow cases, as described in Chapter 5. However, you will not be
able to see any documents related to the case if you are not logged in to the
VIP DocManager server.
Selecting the Display Language

If the VIP ContentExplorer workspace does not display in your preferred language when you log in, you can change the display language at any time. Any change you make takes effect immediately and affects all VIP ContentExplorer messages and prompts. Text displayed from the VIP DocManager database, such as DocLink names and descriptions, is not translated, as it is only stored in the language in which it was entered.

**Note** Depending on an option set by an administrator, you may not be able to do this; the button may not appear on your toolbar.

**To change the VIP ContentExplorer display language**

1. Hover the mouse pointer over the language name at the right side of the toolbar.
2. Select the language you want from the drop-down list.
The VIP ContentExplorer Workspace

The VIP ContentExplorer workspace displays when you start the VIP ContentExplorer application. In the workspace, you can select the server to log into, as described in the previous section. Once you have logged into the server, the **DocFolders**, **DocLinks**, **OmniLinks**, **Saved queries**, **Work Queues**, and **Procedures** folders appear in the *Tree Control* pane. (**Work Queues** and **Procedures** are shown only if you are logged into a VIP WorkflowManager server. Some of the folders may not appear, depending on options set by the VIP ContentExplorer administrator.)

The VIP ContentExplorer workspace has three main sections:

- The **Tree Control** pane
- The **Content Frame** pane
- The toolbar

**Tree Control Pane**

The *Tree Control* pane is located on the left side of the workspace. The top level of the tree shows all the VIP DocManager and WorkflowManager servers you can access. To log on to a server, click it in the list. Depending on your VIP ContentExplorer setup, you may need to enter login information for the server, or for both the DocManager server and WorkflowManager server, as described on page 10.

Once you log in, you see folders for the types of items you can access on the server. Selecting a folder displays the items of that type, a page at a time, in the *Tree Control* pane and/or the *Content Frame*. See “Navigating the Tree Control Pane” on page 17 for more information.

Each type of item is described below. You may not see all of these item types; an administrator can set options to show or hide each one.

**Tip**

If you do not see the *Tree Control* pane, it may be collapsed. Click the **Expand Tree Frame** button on the toolbar to show it.

**Note**

Depending on an option set by an administrator, the lists of folders, content classes, DocLinks, and OmniLinks may or may not include the description. By default, the description is displayed.
**DocFolders**

A DocFolder groups and stores documents, images, and uploaded PC files on the VIP DocManager server. Whenever a file of any type is captured and archived, it is stored in a DocFolder. Within a folder, files are organized into Content Classes (these are called DocClasses elsewhere in VIP DocManager). Each Content Class contains either report files or images and captured PC files. A Content Class cannot contain both reports and other files. VIP ContentExplorer lists only report Content Classes, not ones which contain image files. You can find and open image files using either DocLinks or OmniLinks.

Clicking the **DocFolders** folder lists the DocFolders on the server. Clicking a DocFolder displays its report Content Classes.

Clicking a Content Class displays the content objects (reports) it contains. Content objects are listed only in the **Content Frame** pane. See page 24 for more about DocFolders.

**DocLinks**

A DocLink is a query that searches one or more indices across all generations of a document class for value(s) you specify. Click the **DocLinks** folder to list all the DocLinks defined on the current VIP DocManager server.

The DocLinks list displays in both the **Tree Control** pane and the **Content Frame**. Click a DocLink in either list to open the **Query** window for it in the **Content Frame** so you can use the DocLink to search for specific reports or images. See page 27 for more information.

**OmniLinks**

An OmniLink is a query that joins two or more DocLinks with similar indices across two or more document types, letting you search for specific index information across all generations of the joined documents. Click the **OmniLinks** folder to list all the OmniLinks defined on the current VIP DocManager server.

The OmniLinks list displays in both the **Tree Control** pane and the **Content Frame**. Click an OmniLink in either list to open the **Query** window for it in the **Content Frame** so you can use the OmniLink to search for specific reports or images. See page 38 for more information.

**Saved Queries**

You can save any DocLink or OmniLink query you perform so you can easily access it again. When you click the **Saved queries** folder, the queries you have saved are listed in both the **Tree Control** pane and the **Content Frame**. Clicking a saved query generates a hit list for it in the **Content Frame**.

**Note** Queries are saved on the VIP ContentExplorer server, allowing you access to them from any computer.
**Work Queues**

The **Work Queues** folder appears only if you are logged in to a VIP WorkflowManager server as well as a VIP DocManager server. Click the **Work Queues** folder to list the work queues you belong to.

The work queue list displays in both the *Tree Control* pane and the *Content Frame*. Click a work queue in either list to display its cases in a table in the *Content Frame*. For each case, the table shows the case status, case number, description, and the name and description of the step (action) to be performed by users in the selected work queue. See page 45 for more information on working with workflow cases.

**Procedures**

The **Procedures** folder appears only if you are logged in to a VIP WorkflowManager server as well as a VIP DocManager server. Click the **Procedures** folder to list the procedures defined in VIP WorkflowManager.

The procedure list includes the procedure name and description and displays only in the *Content Frame*. Click a procedure in the list to start a new case for that procedure.

**Navigating the Tree Control Pane**

Clicking an item in the *Tree Control* pane, or the plus sign next to it, expands its branch of the tree to show the items, or types of items, it contains—clicking a server lets you log in and see the types of items it contains, clicking a DocFolder shows the Content Classes stored in it, and so on. Some of these lists can get quite long; for example, there could be hundreds or thousands of DocLinks on a VIP DocManager server. VIP ContentExplorer shows these lists a page (20 items) at a time. You can find items that aren’t listed either by going through the list a page at a time or by moving the list to a particular starting point. You do this using the navigation buttons and field which appear just below the item you open:

<table>
<thead>
<tr>
<th>Button or Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous</td>
<td>The <em>Previous</em> button returns to the previous 20 items.</td>
</tr>
<tr>
<td>Next</td>
<td>The <em>Next</em> button lists the next 20 items.</td>
</tr>
</tbody>
</table>
Getting Started with VIP ContentExplorer

18   VIP ContentExplorer User Guide

Content Frame Pane

The Content Frame is located on the right side of the workspace. The contents of this window depend on what type of item is selected in the Tree Control pane. The Content Frame may show:

- The Login screen for a server
- A table listing items of the type selected in the Tree Control—DocFolders, DocLinks, and so on
- A Query form for a specific DocLink or OmniLink
- A hit list showing the results of a query

When it’s showing either an item list table—such as a list of DocLinks—or the hit list from a DocLink or OmniLink query, the Content Frame shows one page of items at a time. By default, there are 40 items per page, but an administrator can change the number. Use the navigation buttons at the bottom of the list to go to another page of items.

Tip If the Content Frame is not wide enough to show all the columns of the displayed list, you can make it wider by clicking the Collapse Tree button.
Frame button on the toolbar. Click the Expand Tree Frame button to show the Tree Frame again.

**Toolbar Buttons**

The toolbar buttons provide access to common VIP ContentExplorer functions. The buttons that appear in the toolbar vary depending on options set by an administrator and on what is currently shown in the content pane. These buttons may appear in the toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Search" /></td>
<td>The <strong>Search</strong> button lets you search for work cases in the work queues folder.</td>
</tr>
<tr>
<td><img src="image" alt="View" /></td>
<td>The <strong>View</strong> button opens the selected document in the Content Viewer or, for some types of images, in the image’s native viewer.</td>
</tr>
<tr>
<td><img src="image" alt="Compare" /></td>
<td>The <strong>Compare</strong> button lets you open two, three, or four documents in a single browser window for comparison.</td>
</tr>
<tr>
<td><img src="image" alt="Print Selected Documents" /></td>
<td>The <strong>Print Selected Documents</strong> button prints all selected documents to the printer you choose.</td>
</tr>
<tr>
<td><img src="image" alt="E-mail Without Annotations" /></td>
<td>The <strong>E-mail Without Annotations</strong> button sends an e-mail message with all currently selected documents attached, to one or more recipients. The documents do not include any annotations added in VIP ContentExplorer. You cannot use this option for documents with critical annotations.</td>
</tr>
<tr>
<td><img src="image" alt="E-mail With Annotations" /></td>
<td>The <strong>E-mail With Annotations</strong> button sends an e-mail message with all currently selected documents attached, to one or more recipients. The documents include all annotations added in VIP ContentExplorer.</td>
</tr>
<tr>
<td><img src="image" alt="Generate URL List" /></td>
<td>The <strong>Generate URL List</strong> button lets you generate and e-mail a list of URLs, one for each document selected in the current hit list.</td>
</tr>
<tr>
<td><img src="image" alt="Capture" /></td>
<td>The <strong>Capture</strong> button displays the Capture dialog box so you can capture a new image file using the current DocLink.</td>
</tr>
<tr>
<td><img src="image" alt="Select All on Page" /></td>
<td>The <strong>Select All on Page</strong> button selects all the documents on the current page of the hit list.</td>
</tr>
<tr>
<td><img src="image" alt="Clear All" /></td>
<td>The <strong>Clear All</strong> button clears all selections you have made on all pages of the current hit list.</td>
</tr>
</tbody>
</table>
### Button Description

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand Tree Frame</td>
<td>The <strong>Expand Tree Frame</strong> button shows the Tree Frame on the left if it is collapsed.</td>
</tr>
<tr>
<td>Collapse Tree Frame</td>
<td>The <strong>Collapse Tree Frame</strong> button collapses the Tree Frame to make the Content Frame wider.</td>
</tr>
<tr>
<td>Display Previous Query</td>
<td>The <strong>Display Previous Query</strong> button returns from a hit list to the DocLink or OmniLink query form.</td>
</tr>
<tr>
<td>Refresh</td>
<td>The <strong>Refresh</strong> button updates and redispalyes the list of items in the Content Frame pane.</td>
</tr>
<tr>
<td>Add This Page</td>
<td>The <strong>Add This Page</strong> button adds the current page—a content class list, content object list, or hit list—to your Internet Explorer favorites list.</td>
</tr>
<tr>
<td>Save This Query</td>
<td>The <strong>Save This Query</strong> button saves the query.</td>
</tr>
<tr>
<td>User Column Editor</td>
<td>The <strong>User Column Editor</strong> button lets you modify what columns are used to sort hit lists in the Content Frame pane, and in what order. Depending on an option set by an administrator, this button may not appear.</td>
</tr>
<tr>
<td>Edit - Default</td>
<td>The <strong>Edit - Default</strong> button lets administrators set the default column sorting for hit lists in the Content Frame pane. Individual users can override this setting for their own use by using the User Column Editor button. Only defined administrators see the Edit - Default button.</td>
</tr>
<tr>
<td>Generate URL</td>
<td>The <strong>Generate URL</strong> button lets you create and e-mail a URL the recipient can use to view the current hit list.</td>
</tr>
<tr>
<td>Check Error Log</td>
<td>The <strong>Check Error Log</strong> button opens and closes a window that displays the VIP ContentExplorer error log.</td>
</tr>
<tr>
<td>Logout</td>
<td>The <strong>Logout</strong> button closes VIP ContentExplorer and disconnects the session between VIP ContentExplorer and all VIP DocManager and VIP WorkflowManager servers.</td>
</tr>
</tbody>
</table>

In addition, there are three links at the right side of the toolbar:

- **Help** displays the online help for VIP ContentExplorer.
- **About** opens a new browser window showing version information for VIP Content Explorer and the VIP DocManager server.
• The language name lets you change the display language. See “Selecting the Display Language” on page 14.
Exiting VIP ContentExplorer

To exit VIP ContentExplorer, click the Logout button on the toolbar. This closes any open windows, such as VIP ContentViewer or WorkflowManager windows, and ends the connections to the VIP DocManager and VIP WorkflowManager servers. If you are logged into more than one VIP DocManager or VIP WorkflowManager server, it logs you out of all servers you are logged into.

Like other Web applications, if you leave the VIP ContentExplorer window open for a period of time without any activity, it will “time-out” and close the connection to the server. If this happens, you will lose any unsaved changes, such as annotations you have added, and you will have to log in again.

**Note** While it is best practice to use the Logout button, if you close the browser window without logging out, ContentExplorer still ends the connections to the VIP DocManager and VIP WorkflowManager servers.

**Note** If you use a URL to open a ContentViewer window (for example, if you are emailed a link to a document), it is possible to close the window without ending the user session on the DocManager server. This can happen in two situations:

- If you close the ContentViewer window before it loads completely.
- If you add annotations, but do not save them, when you try to close the viewer window, a dialog box asks if you want to save your changes. If you close the ContentViewer window without responding to this dialog, the session is not ended.

In both of these cases, the user session will be closed when the time-out period is reached.
Chapter 4

Accessing Content

This chapter describes how to use VIP ContentExplorer to find and work with content (image and report documents) from the VIP DocManager server. Sections include:

- Using DocFolders (see page 24)
- Using DocLinks (see page 27)
- Using OmniLinks (see page 38)

Note: Having a pop-up blocker enabled in your Web browser may prevent VIP ContentExplorer from opening the documents you select. You should either turn off your pop-up blocker while using VIP ContentExplorer or configure the pop-up blocker to allow pop-ups from the VIP ContentExplorer URL. Depending on your version of Windows, you may also need to turn off advanced security to be able to view documents without numerous permission warnings and prompts.
Accessing Content via DocFolders

A DocFolder is an object on the VIP DocManager server. DocFolders group and store captured documents (reports and image files), much like folders are used to group and store papers within a filing cabinet. Within each DocFolder there are one or more Content Classes. Each Content Class can store one or more Content Objects. The Content Objects are the actual captured reports. You can use VIP ContentExplorer to navigate through DocFolders and Content Classes to find and open the report you want, as described below.

For data security and distribution, reports may be divided into segments when they are captured. If a report has segments, you can find and open the segment(s) you are permitted to by following the procedure below.

**Note**  
Content Classes are called DocClasses elsewhere in VIP DocManager.

**Note**  
Each VIP DocManager Content Class stores either report files or image files, but not both. With VIP ContentExplorer, you can list and open only report Content Classes through their DocFolders. To access image files, you must use DocLinks or OmniLinks, as described later in this chapter.

**To open a report or report segment through DocFolders**

1. Click the **DocFolders** folder to list the DocFolders on the server.

2. Navigate through the list as needed, as described on page 17.
3. In either the Tree Control pane or the Content Frame, click the desired DocFolder to list its content classes.

4. Navigate through the list as needed, as described on page 17.

5. In either the Tree Control pane or the Content Frame, click the desired content class to list its content objects (reports).

   **Tip** To list all content objects in the folder, from any content class, click All Content Objects For This Folder at the bottom of the list of content classes in the Tree Control pane.

6. Use the arrow buttons at the bottom of the list to scroll through the list to find the object(s) you want. You can sort the list by Name, Description, or Date by clicking the column heading. Click the heading again to reverse the order.
7. To open a single complete report, do one of the following:
   - In the Select column, click the View Content Object button for the report.
   - Select the check box for the report, then click the View button.
   This opens the document in the VIP ContentViewer. For information about working with open documents, see page 69.

8. To view multiple complete reports, each in a separate window:
   - Select the check box for each report.
   - Click the View button.
   - To clear the check boxes, click the Clear all button.
   This opens each selected document in the VIP ContentViewer. For information about working with open documents, see page 69.

9. To view two, three, or four reports next to each other in a single window:
   - Select the check box for each report.
   - Click the Compare button.
   - To clear the check boxes, click the Clear all button.
   This opens the selected documents in individual VIP ContentViewer panes within a single browser window. For more information about using the comparison window, see page 78.

10. To view one or more report segments:
    - Click the View RD Segment button for the report containing the segment. This lists the segments you can view for that report.
    - To view one segment, either:
      - Click its View RD Segment button.
      - Select the check box for the segment, then click the View button.
      To view more than one segment, each in a separate window:
      - Select the check box for each segment to view.
      - Click the View button.
      - To clear the check boxes, click the Clear all button.
      This opens each selected segment in the VIP ContentViewer. For information about working with open documents, see page 69.

    Tip You can also email one or more selected reports. See page 114.
Accessing Content via DocLinks

A DocLink is a query that uses a collection of indices to search all Content Objects in a Content Class for reports or images with one or more specified values. A common way to find the document you want is to search for those with specific DocLink index values, such as an account or invoice number. Once you find the desired document, you can open it, or modify, copy, or delete the index values.

You can also use DocLinks to capture new files into VIP DocManager through VIP ContentExplorer. See page 35.

The DocLink Concept

VIP DocManager contains a listing of DocClasses. Each DocClass represents metadata, including a set of definitions for index fields and other attributes. For reports, index fields are defined based on a location inside a document (page, row, and column). For images, index fields are not based on location, but are additional image metadata. After indexing, documents are stored on the VIP DocManager server based on the index values.

To query for documents based on index values, the VIP DocManager server has a predefined set of queries (DocLinks and OmniLinks). A DocLink is associated with a single DocClass and uses its own index list. An OmniLink is associated with multiple DocClasses and uses its own index set that is linked to some indices in DocClasses. For more information about OmniLinks, see page 38.

VIP ContentExplorer displays lists of DocLinks in both the Tree Control and the Content Frame. When you select a DocLink, a query form appears. You enter the index values to search for and VIP ContentExplorer displays the matching reports or images in a hit list.
A Case Study Using DocLinks

Susan, who works in the Accounts Receivable department, is responsible for customer account inquiries. She receives a call from ACME Inc. regarding invoice #123. Since the Accounts Payable department sends dozens of invoices to ACME each month, Susan must search the monthly invoice reports for invoice #123.

Susan uses DocLinks to search all the monthly invoice reports for invoice #123. She begins by listing the DocLinks defined on the VIP DocManager server and selecting the invoice number DocLink for the monthly invoice report. She selects that DocLink to display its Query form.

In the Invoice# field, she types 123 and presses Enter. VIP ContentExplorer locates the monthly invoice report which includes invoice #123 and displays that report page on her workstation.

Susan can now answer the customer’s questions.

Using DocLinks to Find Content

To find a report or image using DocLinks, you select the DocLink to use, then enter the index values to search for. You can also limit the hits to files captured in a date range you select. Follow the procedure below.

Tip If you will be performing the same search frequently, you can save it for repeated use. See page 32.

To find content using a DocLink

1. Click the DocLinks folder to list the DocLinks on the server.
The *Tree Control* shows the name of each DocLink; it may also show the description, based on a setting by a VIP DocManager administrator. The *Content Frame* always shows the name, description, and report name.

2. Navigate through the list as needed. How to navigate in the *Tree Control* is described on page 17. You have these options to navigate in the *Content Frame*:

- DocLinks are shown a page at a time. To go to the next or previous page, click one of the arrows below the list.

- To search for a DocLink, type the text to search for in the field at the top of the column to search and click the **Search** icon.

  To make the search case-sensitive, click the box to the left of the search text field before clicking the **Search** icon.

  You can search by only one column at a time. To search on two columns, first perform a search on one, then the other. The second search only looks for matches in the list of DocLinks which matched the first search.

- To sort the list by any column, click the column heading text. Click it again to reverse the order. The sort is case-sensitive.

*Note*  All searches and sorts are performed on the entire current DocLink list (which may be the result of a previous search), not just the displayed page.

- To return to the entire list of DocLinks, click the **DocLinks** folder in the *Tree Control*.

*Tip*  There is a maximum number of DocLinks which VIP ContentExplorer can sort, set by an administrator (2000 by default). If you have more DocLinks than this, first perform a search to get a shorter list, then sort the list.

3. Click the DocLink you want, in either list. Its *Query* form displays in the *Content Frame*. Here is a sample form for a DocLink with three indices.
4. Fill in the index values to search for. You can enter partial values by including an asterisk (*) at the beginning and/or end of your entry. For example, entering SA* will find all values starting with SA, while *SA* will find all entries with SA anywhere in them. If an administrator has defined a list of possible values for the DocLink, you can select one from the list.

You can leave any field blank to match any value for that index.

5. To find only objects captured in a given date range, enter the From Date and/or To Date in those fields. (The date fields appear for all DocLinks.) You can either type the date in the format shown or click the button next to the field to use the Calendar dialog.

To use the Calendar dialog, select the month and year, then click the day to enter.

If you enter both a From Date and To Date, all hits must have been captured between those dates. If you enter only a From Date, all hits must have been captured on or after that date. If you enter only a To Date, all hits must have been captured on or before that date.

6. If the DocLink has one or more offline versions, choose whether to search the online DocLink or one of the offline DocLinks.

Note: An offline DocLink is an earlier version of the DocLink. It may include different indices than are currently in the DocLink. Searching an offline DocLink will only find documents that were captured and indexed before the DocLink definition changed.
7. Click **Search** to perform the search. The hit list for the search is displayed in the **Content Frame**.

For each document, the hit list displays an icon indicating the document type, DocLink index values, and other information about the document.

You can use the **Next (»)** and **Previous (‹)** arrows at the bottom of the list to view additional hits.

You can modify what is shown, either sorting the list differently or removing columns you do not want:

- To sort the hit list by a specific index value, click the underlined column heading for the index value. This sorts the entire list, not just the hits shown. Click the heading again to change the sort order. An arrow icon in the column heading indicates which column you are sorting by and the direction of the sort (the icon at the right indicates an ascending sort).

  The sort order for an index depends on the type of data in it—text, numeric, currency, or date/time—and its format. Both of these are set by an administrator.

  **Note** For performance reasons, if the list is extremely long, VIP ContentExplorer may not retrieve all of it from the server before sorting and redisplaying it. The maximum number of entries it will retrieve and sort is set by an administrator; by default, it is 1000. If your hit list has more entries than this, we recommend you refine your query to return a shorter list of hits.

- To remove a column from the display, click the x at the upper right of the column heading. To return all columns to the display, click the **Show All Columns** button at the top right of the **Content Frame**.

Also, the User Column Editor may give you more options for modifying the hit list display. See page 33.

**Tip** If the hit you want is not found, click the **Display Previous Query** button to return to the query form, where you can change your entries.
8. To display the file for a hit, either:
   - Click the file type icon in the Select column for the hit.
   or:
   - Hover the pointer in the Action column for the hit, then select View.

To open more than one file at once:
   - Click the check box for each hit, then click the View button.

Each selected document opens in either the VIP ContentViewer or in the viewer for its file type. For information about working with open documents, see page 69.

   **Tip** To select all the documents on the current page, click the Select All button.

   To clear all your selections, click the Clear All button.

9. To view two, three, or four files next to each other in a single window:
   - Click the check box for each hit to open.
   - Click the Compare button.

   This opens the selected documents in individual VIP ContentViewer panes within a single browser window. For general information about working with open documents, see page 69. For specific information about using the comparison window, see page 78.

10. If there are more hits than fit on one page (by default, there are 40 hits per page, but an administrator can change the number), the Fetch More Pages icon appears at the bottom of the list. Click it to retrieve the rest of the hits. Once you have retrieved the entire list, you can click the Next (✓) and Previous (✗) arrows to move a page at a time, or click a page number to go to that page of the list.

   Any hit you've selected on the current page stays selected when you move to a new page.

   **Note** As when sorting the hit list, the maximum number of entries VIP ContentExplorer will retrieve is set by an administrator; by default, it is 1000. If your hit list has more entries than this, we recommend you refine your query to return a shorter list of hits.

### Saving Queries

In many situations, there will be some queries that you want to run frequently. Rather than having to re-enter the query values each time, you can save any query so you can then rerun it at any time. The queries you save are for your use only. Each ContentExplorer user can have a separate list of saved queries.

Saving queries works for both DocLink queries and OmniLink queries (see page 38 for information about OmniLinks). Follow the procedures below to save and rerun queries.
To save a DocLink or OmniLink query

1. Run the DocLink or OmniLink query.
2. When the hit list for the query is displayed, click the Save this Query button in the toolbar. The Save Query dialog opens.

![Save Query dialog](image)

3. If you want, change the name of the query to something that is more meaningful.

   **Tip** Do not use any of the following characters in a query name: ;+-(){}[]. ContentExplorer’s security features could prevent a query that uses one or more of these characters from displaying.

4. Click Save Query.

To run a saved query

1. In the Tree Frame, click the Saved queries folder to list your saved queries.
2. If you have a large number of saved queries, you can navigate and search the list like you can the DocLink list.
3. In either the Tree Frame or the Content Frame, click the query you want to display its hit list.
4. You have the same options and abilities that you do with a DocLink or OmniLink hit list. See those procedures for more information.

The User Column Editor

**Note** The User Column Editor can be turned on or off by a VIP DocManager administrator. If the User Column Editor button does not appear in your toolbar, you cannot use this feature. It is always available to administrators.

For greater control over the information shown in the hit list, you can use the User Column Editor to specify what columns to show, in what order, and the sort order to use for each one. The changes you make with the User Column Editor apply only to the hit list for the current DocLink—you can have different column settings for different DocLinks—and only to you—other users using the same DocLink don’t see your settings.
To use the User Column Editor to define the columns in the hit list display

1. Click the User Column Editor button in the toolbar. This displays the User Column Editor window.

Columns in the Unsorted Columns list won’t be shown in the hit list table; those in the Sorted Columns list will.

2. In the Unsorted Columns list, select one or more columns to display. You can select multiple columns by holding the CTRL key and clicking each one, or a range by clicking the first column in the range, then holding SHIFT and clicking the last column. Click Add. This moves the selected columns to the Sorted Columns list. Repeat this step until all the columns you want displayed are shown in the Sorted Columns list.

3. In the Sorted Columns list, arrange the columns in the order you want them to appear (from left to right) in the hit list. The column at the top of the list will appear first, and so on. The list will be sorted according to the first displayed column. If there are duplicate values in the first column, those hits will be sorted using the second column, and so on.

To move a column up in the list, click it, then click Up. To move a column down, click it, then click Down.

To change the sort order for a column, double-click its entry in the Order field. 0 indicates an ascending sort; 1 means descending.

To move a column from the Sorted Columns list to the Unsorted Columns list, click it, then click Remove. The column won’t appear in the hit list display.

4. When you’ve selected the columns you want and they are in the desired order, click Save.

5. Click Close Window.
Using DocLinks to Capture a Content Object

You can use VIP ContentExplorer to capture a file from your local computer to the VIP DocManager server. You do this through a DocLink; this determines the DocClass the file is captured to and lets you associate index values with the captured file.

**Note** You can only capture files using a DocLink for an image document class. You cannot capture to a report document class through VIP ContentExplorer.

The capture feature is available only if a VIP DocManager administrator has given you permission to capture documents to the document class.

**To capture content**

1. Display a hit list for the image DocLink you want to use for the file capture (see page 28). The values you enter on the Query form do not matter; you can leave all fields blank and just click Search.

   The Capture button displays at the top of the ContentExplorer workspace.

2. Click the Capture button to display the Capture dialog box.

3. In File path, either type the path to the file to capture or click Browse and select the file.

4. Type a Comment.

5. The Index List box contains a field for each index in the DocLink. Type the value to use for each index.

   **Tip** If an index is set up by an administrator with a list of allowable values, when you start typing, VIP ContentExplorer shows matching values (a value is a match if it contains your entry anywhere in it, not just at the start). You can type the entire value or select the one you want from the list.
6. To delete the original file after it is captured to the server, check **Delete Given File After Upload**. To keep the original file, clear this box.

7. Click **Submit**.

The file is captured to the DocClass associated with the DocLink, with the index values you entered. If there is a VIP WorkflowManager procedure associated with the DocClass, VIP DocManager starts a new workflow case.

**Editing DocLink Values**

At times, you may want to change the index values for a particular report or image. You can do this by editing a DocLink hit for that document.

**To edit a DocLink hit**

1. Use steps 1 - 6 of “To find content using a DocLink” on page 28 to display a hit list including a hit containing the index value you want to modify.

2. Hover the pointer in the **Action** column for the hit, then select **Edit Index Values**. This displays the **Update Index Values** page.

<table>
<thead>
<tr>
<th>Invoice Date</th>
<th>MAY-01-2009</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create date</td>
<td>11/09/2009</td>
</tr>
</tbody>
</table>

3. Enter the new value for each index you want to change.

4. Click **Update Hit**.

**Copying DocLink Values**

In some situations, you may want to create new DocLink values for a report or image, based on an existing DocLink hit. You can do this by displaying the existing hit, modifying the value or values you want to change, then making a copy of the hit using the new values.

**Note** You cannot copy a DocLink if revision control is enabled for the document. Revision control is described in Chapter 6.
Accessing Content via DocLinks

To copy a DocLink hit

1. Use steps 1 - 6 of “To find content using a DocLink” on page 28 to display a hit list including a hit containing the index value you want to copy.

2. Hover the pointer in the Action column for the hit, then select Edit Index Values. This displays the Update Index Values page.

   ![Update Index Values](image)

<table>
<thead>
<tr>
<th>Invoice Date</th>
<th>MAY-01-2009</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create date</td>
<td>11/09/2009</td>
</tr>
</tbody>
</table>

3. Enter the new value for each index that should be different in the copied hit.

4. Click Copy Hit.

Deleting DocLink Values

If a report or image has index values that were entered incorrectly, or that no longer apply to it, you may want to delete the hit containing those values. You can do so following the procedure below.

To delete a DocLink hit

1. Use steps 1 - 6 of “To find content using a DocLink” on page 28 to display a hit list including the hit you want to delete.

2. Hover the pointer in the Action column for the hit, then select Edit Index Values. This displays the Update Index Values page.

3. Click Delete Hit.
Accessing Content via OmniLinks

An OmniLink joins DocLinks of two or more content classes, letting you search for specific index values in all content objects in multiple content classes with one search.

The OmniLinks Concept

A DocLink lets you search the documents in one content class for specific values. An OmniLink links DocLink indices from two or more content classes; when you search using an OmniLink, you search index values in all the documents in some or all of the content classes that the DocLinks are defined for. This can let you find related documents of different types with one search, as in the example in the next section.

OmniLinks are defined by the System Administrator. See the VIP DocManager Administrator Guide for information on defining OmniLinks.

A Case Study Using OmniLinks

Susan, who works in the Accounts Receivable department, is responsible for maintaining the Accounts Receivable Journal and the monthly invoice report. Both reports contain an Invoice # DocLink and a Customer # DocLink.

The System Administrator at her company has created an OmniLink called Invoice #, which links the Invoice # DocLink index for the Accounts Receivable Journal and the Invoice # DocLink index for the Monthly Invoice Report.

Susan receives a call from ACME Inc. regarding the charges included on Invoice #123 and the payments applied to that invoice. She uses the Invoice # OmniLink to search the Monthly Invoice Report and the Accounts Receivable Journal for information about invoice #123.

The first thing Susan does is list the OmniLinks defined in VIP DocManager. From that list, she selects the Invoice # OmniLink. Next, she displays a list of the report types joined by the Invoice # OmniLink—in this case, the Monthly Invoice Report and the Accounts Receivable Journal.

To view the reports for invoice #123, she selects both reports and types 123 in the Invoice # field for the OmniLink. VIP ContentExplorer locates the Monthly Invoice Report and Accounts Receivable Journal which include invoice #123 and lists the two reports in the Content Frame.

To see the reports, Susan selects them from the list. A new browser window opens for each report, showing the page containing information for invoice #123. Susan can now answer the customer’s questions regarding charges and payments for invoice # 123, and can reprint the invoice if desired.
The following illustration shows a sample OmniLink that combines two DocLinks.

**Using OmniLinks to Find Content**

To find reports or images using OmniLinks, you select the OmniLink to use, then enter the index values to search for. You can also limit the hits to files captured in a date range you select, and choose the content classes to include in the search. Follow the procedure below.

*Tip* If you will be performing the same search frequently, you can save it for repeated use. See page 32.

**To find content using an OmniLink**

1. Click the **OmniLinks** folder to list the OmniLinks on the server.

2. Navigate through the list as needed, as described on page 17.
3. Click the OmniLink you want, in either list. The content classes the OmniLink is defined for are listed beneath it in the Tree Control pane and its Query form displays in the Content Frame. Here is a sample form for an OmniLink with two indices and two content classes.

<table>
<thead>
<tr>
<th>OmniLink</th>
<th>INVOICEALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice number</td>
<td></td>
</tr>
<tr>
<td>Invoice amount</td>
<td></td>
</tr>
<tr>
<td>From Date :</td>
<td>mm/dd/yyyy</td>
</tr>
<tr>
<td>To Date :</td>
<td></td>
</tr>
</tbody>
</table>

4. To search only one of the content classes the OmniLink is defined for, click the content class you want to search in the list in the Tree Control pane. The Query form redisplays without the content class list. Only the class you selected will be searched.

5. Fill in the index values to search for. You can enter partial values by including an asterisk (*) at the beginning and/or end of your entry. For example, entering SA* will find all values starting with SA, while *SA* will find all entries with SA anywhere in them. If an administrator has defined a list of possible values for the index, you can select one from the list.

You can leave any field blank to match any value for that index.
6. To find only objects captured in a given date range, enter the **From Date** and/or **To Date** in those fields. (The date fields appear for all OmniLinks.) You can either type the date in the format shown or click the button next to the field to use the **Calendar** dialog.

To use the **Calendar** dialog, select the month and year, then click the day to enter.

If you enter both a **From Date** and **To Date**, all hits must have been captured between those dates. If you enter only a **From Date**, all hits must have been captured on or after that date. If you enter only a **To Date**, all hits must have been captured on or before that date.

7. If you did not select a content class in step 4, clear the checkboxes for any classes you do not want to include in the search. By default, all content classes the OmniLink is defined for are searched.

8. Click **Search** to perform the search. The hit lists for the search are displayed in the **Content Frame**. There is a separate list for each content class.

**Note**  To see a hit list of all documents for this OmniLink, leave the index fields blank and click the **Search** button.
For each hit, the hit list displays revision history information, OmniLink indices, and status icons.

You can modify what is shown, either sorting the list differently or removing columns you do not want:

- To sort the hit list by a specific index value, click the underlined column heading for the index value. This sorts the entire list, not just the hits shown. Click the heading again to change the sort order. An arrow icon in the column heading indicates which column you are sorting by and the direction of the sort (the icon at the right indicates an ascending sort).

  The sort order for an index depends on the type of data in it—text, numeric, currency, or date/time—and its format. Both of these are set by an administrator.

**Note**  For performance reasons, if the list is extremely long, VIP ContentExplorer may not retrieve all of it from the server before sorting and redisplaying it. The maximum number of entries it will retrieve and sort is set by an administrator; by default, it is 1000. If your hit list has more entries than this, we recommend you refine your query to return a shorter list of hits.

- To remove a column from the display, click the \( \times \) at the upper right of the column heading. To return all columns to the display, click the **Show All Columns** button at the top right of the **Content Frame**.

**Tip**  If the hit you want is not found, click the **Display Previous Query** button to return to the query form, where you can change your entries.

9. To display the file for a hit, either:

   - Click the file type icon in the **Select** column for the hit.

   or:

   - Hover the pointer in the **Action** column for the hit, then select **View**.

To open more than one file at once:

- Click the check box for each hit, then click the **View** button.

Each selected document opens in either the VIP ContentViewer or in the viewer for its file type. For information about working with open documents, see page 69.

**Tip**  To select all the documents on the current page, click the **Select All** button.

To clear all your selections, click the **Clear All** button.
10. To view two, three, or four files next to each other in a single window:
   • Click the check box for each hit to open.
   • Click the Compare button.

   This opens the selected documents in individual VIP ContentViewer panes within a single browser window. For general information about working with open documents, see page 69. For specific information about using the comparison window, see page 78.

11. If there are more hits than fit on one page (by default, there are 40 hits per page, but an administrator can change the number), the Fetch More Pages icon appears at the bottom of the list. Click it to retrieve the rest of the hits. Once you have retrieved the entire list, you can click the Next and Previous arrows to move a page at a time, or click a page number to go to that page of the list.

   Any hit you’ve selected on the current page stays selected when you move to a new page.

   **Note**   As when sorting the hit list, the maximum number of entries VIP ContentExplorer will retrieve is set by an administrator; by default, it is 1000. If your hit list has more entries than this, we recommend you refine your query to return a shorter list of hits.

   Use the scroll bar at the right of the Content Frame to see the hit lists for additional content classes.
Chapter 5

Working with Workflow Items

VIP WorkflowManager allows documents to be routed through predefined steps as part of a workflow process. These steps and processes are defined by a VIP Workflow Administrator. This chapter covers how to work with workflow items and procedures in VIP ContentExplorer. You can perform two basic workflow functions in VIP ContentExplorer:

• You can find, open, and process a workflow item (individual case step) from one of your work queues, so the case can proceed to the next step. This includes viewing the document(s) related to the step and filling out the form associated with the step.

• You can start a new case based on an existing workflow procedure.

Sections relating to VIP Workflow Manager in this chapter describe:

• Finding and opening work items
• Working with work items
• Opening a new workflow case

VIP DocManager and VIP ContentExplorer also support working with Open Text Workflow Server .NET Edition (previously called Captaris Workflow). A section at the end of this chapter describes the interaction between VIP ContentExplorer and Workflow Server .NET.
Finding and Opening Work Items

In VIP WorkflowManager, each step of a procedure case is assigned to a *work queue*. Each work queue holds the cases currently assigned to a particular user or group of users; a user with access to the queue needs to process the step before the case moves on to the next step.

In VIP ContentExplorer, you can display all the work queues you have access to. You can then display the steps—called work items—waiting in each queue, select the one you want, and open it so you can perform the action necessary to fulfill that step of the case. The procedure below describes how to open a work item through a work queue. You can also search a work queue for items meeting certain criteria; see page 49.

**To open a work item**

1. Click the *Work Queues* folder to list the queues you have access to.

2. Navigate through the list as needed, as described on page 17.

3. In either the *Tree Control* or the *Content Frame*, click the *Select* icon for the work queue containing the item you want to open. The items in that queue are listed in the *Content Frame*.

![OpenText VIP Content Explorer interface](image)
The first column in the list displays icons showing each item’s status.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td>The item is new; it has not been opened since it arrived in the queue.</td>
</tr>
<tr>
<td><img src="image" alt="Saved" /></td>
<td>The item has been previously opened and saved.</td>
</tr>
<tr>
<td><img src="image" alt="Locked" /></td>
<td>The item is locked and cannot be accessed, usually because another user has it open.</td>
</tr>
</tbody>
</table>

If a case has been given a deadline, it will also have one of these icons in the first column:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Deadline" /></td>
<td>The case has a deadline which has not yet been reached.</td>
</tr>
<tr>
<td><img src="image" alt="Past Deadline" /></td>
<td>The case has a deadline which is in the past; the deadline was not met.</td>
</tr>
</tbody>
</table>

If a case has been marked urgent, it will also show this icon:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Urgent" /></td>
<td>This case is urgent.</td>
</tr>
</tbody>
</table>

The remaining columns show information stored for the case; these will be different depending on the procedure and step. You can modify the display, sorting the list differently and/or removing columns you do not want:

- To sort the list by a specific column, click the underlined column heading. This sorts the entire list, not just the cases shown. Click the heading again to change the sort order. An arrow icon in the column heading indicates which column you are sorting by and the direction of the sort (the icon at the right indicates an ascending sort). Also, see the next section for more sorting options.
- To remove a column from the display, click the x at the upper right of the column heading. To return all columns to the display, click the Show All Columns button at the top right of the Content Frame.

4. As needed, use the Next and Previous buttons at the bottom of the list to view additional items.

5. Click anywhere in the row for the desired item to open its dynamic form. You can then work with the item. See page 50.
You can also search a queue to find the item you want. See page 49.

**Selecting Columns and Sorting the Item List**

In the User Column Editor window, you can choose what columns to show in the work item list, the order to display them in, and which ones to use when sorting the list. Any changes you make apply only to the current work queue—you can have different column settings for different work queues.

**To select the columns to show and their order**

1. Click the User Column Editor button in the toolbar to display the User Column Editor window.

![User Column Editor Window]

The Unsorted Columns box contains columns not displayed for the selected work queue. The Sorted Columns box contains displayed columns for the selected work queue.

2. In the Unsorted Columns list, select one or more columns to display. You can select multiple columns by holding the CTRL key and clicking each one, or a range by clicking the first column in the range, then holding SHIFT and clicking the last column. Click Add. This moves the selected columns to the Sorted Columns list.

Repeat this step until all the columns you want displayed are shown in the Sorted Columns list.

3. In the Sorted Columns list, arrange the columns in the order you want them to appear (from left to right) for the work queue. The column at the top of the list will appear first, and so on. The list will be sorted according to the first displayed column. If there are duplicate values in the first column, those items will be sorted using the second column, and so on.

To move a column up in the list, click it, then click Up. To move a column down, click it, then click Down.

To change the sort order for a column, double-click its entry in the Order field. 0 indicates an ascending sort; 1 means descending.
To move a column from the Sorted Columns list to the Unsorted Columns list, click it, then click Remove. The column won’t appear in the work queue display.

4. When you’ve selected the columns you want and they are in the desired order, click Save.

5. Click Close Window.

**Note** VIP ContentExplorer Administrators can change the default column display for all users for a work queue by using the Admin Column Editor button. This works the same way as the User Column Editor window.

### Searching for Work Items

Rather than just paging through the list of cases in a work queue, you can search a queue for items that match the criteria you want.

**To search a work queue**

1. Click the work queue to search.

2. Click the **Search** button to display the Search WorkCases dialog box.

   ![Search WorkCases dialog box](image)

   The search criteria fields are the displayed columns for the selected work queue. You cannot search based on a field if the column for it is not displayed. See page 48.

3. Type the values to search for in the search fields. You can use a single asterisk (*) as a wildcard (it replaces one or more characters). Leave a field blank to not use it.

4. To find only cases in certain states, check the **Locked**, **Urgent**, **Deadline**, and/or **Expired** check boxes. If you check more than one box, a case must match all the states you check to be counted as a match.

5. Select whether to search **All** cases or only **New** ones.

6. Click **Search** to begin the search.

   You can click the **Reset** button to clear all criteria or **Cancel** to close the dialog without searching.

7. A hit list of matching items is returned in the Content Frame. Click an item to open it.
Working With Workflow Items

Once you’ve opened a work item, you see its dynamic form and, generally, the document associated with the case. You can then take whatever action the form requires and send the case on to its next step.

The next section discusses the window that opens to display a work item. After that we describe the procedure for processing a work item.

The Work Item Window

When you open a work item, VIP ContentViewer opens a separate browser window. This window is divided into two panes:

- The left pane shows the dynamic form for the work item. This is described below.
- The right pane is the VIP ContentViewer. In most cases, this automatically shows the VIP DocManager document related to the work item. You may be able to view other documents using the Views field in the dynamic form. For instructions on working with the ContentViewer, see page 69.

The dynamic form enables you to enter specific information related to the selected work item, view any documents associated with it (which are opened in the VIP ContentViewer), select an action to take, and release the item to the next step in the workflow process. Because the WorkflowManager Administrator designs a unique form for each step of each procedure, the form you see when you open a work item depends on the procedure and step the item is an instance of.

The form pane contains two parts:

- Command buttons and possibly the Action and Views fields across the top.
- The fill-in fields for the form itself.

The sections below describe each of the items in the form pane.

**Note** Forms using SVStep scripts may display in VIP ContentExplorer; however, the SVStep script may not be executed.

Command Buttons

There are three command buttons at the top of the form pane:

- The **Cancel** button cancels any input entries and closes the form without saving any changes made to the form.

**Note** **Important!** You must use the **Cancel** button to close a form. Do not use the Windows **Close** button (in the upper right corner of the window) to close a form. If you use the Windows **Close** button, the case remains locked and neither you nor other users will be able to open it until a Workflow Administrator unlocks it.
The **Save** button saves all changes made to the form without releasing the form to the next step.

The **Done** button closes the form and forwards the case to the next step in the workflow.

**Note** Administrators also see a **Refresh** button, which they can use to load the updated version when a form has been changed.

**Action Drop-down Field**
The **Action** drop-down field requires you to select from a predefined list of values, such as Forward, Submit, Reject, and so on. The field appears only if it is assigned to the form by a VIP WorkflowManager Administrator. The Administrator also maintains the list of actions.

**Views Field**
The **Views** field lets you find and display additional documents—stored in VIP DocManager—related to the work item. You do this by selecting and executing a **view**. When creating a procedure, a VIP WorkflowManager Administrator may define one or more views for each workflow step. A view is a specific DocLink or OmniLink query which finds documents—stored in VIP DocManager—related to the step.

**Form Fields**
The fields which appear in the body of the dynamic form can contain any information about the workflow item. Each form is designed for the individual procedure and step it appears for. Typically, a form includes some combination of these types of fields:

- A case description to help in identifying a case. Case descriptions are defined and maintained by the WorkflowManager Administrator.
- A step description name. This is usually the case number of the selected case. The case number is automatically assigned by VIP WorkflowManager when the case is created and uniquely identifies the case.
- A comments field allowing optional text entries.
- Other fields may contain predefined index values associated with the current case and assigned to the document, or require you to enter information pertaining to the current step.
Processing Work Items

To process a work item

1. Select the item and display its dynamic form, as described on page 46. In most cases, the document associated with the case automatically displays in the VIP ContentViewer.

   **Note** Whether or not the document for the item appears automatically is controlled by an option set by a VIP ContentExplorer Administrator.

2. If the **Views** field is displayed, you can display other documents related to the case, as needed:
   - Click the down-arrow next to the **Views** field. This displays a list of the views for this work item.
   - Click the view to execute. This runs the defined DocLink or OmniLink query and displays the hit list for it in a pop-up window.
   - Select the document to open from the hit list, as you do for hit lists in the **Content Frame**. The document opens in a ContentViewer window.

3. Enter information in the form fields as required. Some fields may require an entry while others are optional.

4. If there is an **Action** field, select the appropriate action.

5. Click **Save** to save your entries.

6. When the form is complete, click **Done** to forward the case to the next step in the workflow based on your entries and choices.
Starting a New Work Case

With VIP ContentExplorer, you can view the procedures defined on the VIP WorkflowManager server and start a new case for any procedure you select. In most cases, this should be a fairly rare occurrence, as new cases are typically started when a document is captured to a DocClass which has an associated procedure. When you start a case using the procedure below, there is no document associated with the case.

To start a new work case

1. Click the Procedures folder to list the defined procedures in the Content Pane.

2. As needed, use the Next and Previous buttons at the bottom of the list to view additional procedures.

3. Click anywhere in the line of the procedure you want to start a case for. This displays the Start New Case window.

4. Type the description for the case.

5. Click Start Case.
Working with Captaris Workflow

Note  The latest versions of Captaris Workflow have been renamed to OpenText Workflow Server, .NET Edition, or simply OpenText Workflow Server.

VIP DocManager can be configured so that capturing some or all documents starts a workflow instance in Captaris Workflow. The captured document is then tied to the workflow, so you can open it from the Captaris Workflow Web client. When you do this, the document is displayed in the VIP ContentExplorer Content Viewer.
Chapter 6

Revision Control

VIP DocManager’s revision control system lets users update archived documents by checking them out from the VIP DocManager server, modifying them, then checking in the modified version. When you check in a modified document, it becomes a new revision of the document. All previous versions are still stored in VIP DocManager, and are still available if needed.

Sections in this chapter describe:

- The overall revision control process
- Checking a document in to revision control
- Checking a document out for revision
- Checking in a new revision of a document
- Viewing a document’s revision history or an earlier document revision
- Reverting a document to an earlier revision
Document Revision Overview

Not all archived documents are eligible for revision control. Revision control can be used only for files stored in an image-type DocClass—image files and captured PC-format files, such as spreadsheets. You cannot use revision control with reports.

For images, a VIP DocManager Administrator decides which DocClasses use revision control and which do not. In VIP ContentExplorer, you can know when a document is subject to revision control, because it shows the check-in and check-out icons in the **Edit** column of its DocLink or OmniLink hit list:

- ![Check-out icon](image)
- ![Check-in icon](image)

The Revision Control Process

The revision control process starts when you capture a document (through a DocLink) to a DocClass which has revision control turned on. During the capture process, you include a comment describing the initial revision, and the file is captured as the first revision of its content object. The capture of a document into revision control is also known as the *initial check-in*.

Once you’ve checked a document in to revision control, you or other users can view it like any other captured file. In addition, you can **check out** the document (unless it has been protected; see page 67). This stores a copy of the file on your local file system; you can open and modify the copy, then **check in** the file as a new revision of the content object. The new version is stored on the VIP DocManager server and becomes the *head revision* of the document—the one a user sees when viewing the document. However, the older revisions are still stored in VIP DocManager, and are accessible if needed.

**Note** Depending on a setting by a VIP DocManager administrator, you may also be able to create new revisions by adding or modifying annotations within VIP ContentExplorer. See page 64.

While you have a document checked out, it is *locked*; other users cannot also check it out. This prevents two people from trying to update the same document at the same time. You can also choose to keep others from viewing a document while it is checked out, but you do not have to.

This is the basic revision control process: initial check-in, followed by a check out/check in cycle each time the document is updated. The rest of this chapter describes each of these steps in detail.
Revision Control Tips

Each time you check a document in or out, you can enter a comment that gets attached to that revision of the document, and you can update the index values for the new revision. Here are some tips to consider, which may make it easier for you to find the revision you are looking for when searching for a revision-controlled document.

Comments

When checking in a document, consider entering comments to identify each document revision, such as: Original or Revision 1. You can enter a comment when first checking in a document, when checking the document out, or when reverting to an earlier version of a document. You must enter a comment when checking in a new revision of a document.

Index Values

When entering index values for an original document or a later revision, you may want to use easily identifiable labels, such as the document title (for example, Purchasing Procedure) for the first index value, and the purpose of the changes (for example, Editorials) for another index. This can help you identify the index values later when viewing a list of documents.
Initial Check In

The process for the initial capture and check in of a document into revision control is exactly the same as capturing a document that does not use revision control.

To capture and check in a document

1. Display a hit list for the image DocLink you want to use for the capture (see page 27). Revision control must be enabled for the DocClass the DocLink is for.
   The values you enter on the Query form do not matter; you can leave all fields blank and just click Search.
   The Capture button displays at the top of the ContentExplorer workspace.
2. Click the Capture button to display the Capture dialog box.

<table>
<thead>
<tr>
<th>Capture</th>
</tr>
</thead>
<tbody>
<tr>
<td>File path</td>
</tr>
<tr>
<td>[Browse]</td>
</tr>
</tbody>
</table>

| Comment |

<table>
<thead>
<tr>
<th>Index List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index 1</td>
</tr>
<tr>
<td>Index 2</td>
</tr>
</tbody>
</table>

3. In File path, either type the path to the file to capture or click Browse and select the file.
4. Type a Comment.
5. The Index List box contains a field for each index in the DocLink. Type the value to use for each index.
6. Click Submit.
   The file is captured to the DocClass associated with the DocLink, with the index values you entered. If there is a VIP WorkflowManager procedure associated with the DocClass, VIP DocManager starts a new workflow case.
Checking Out a Document

When you want to modify an archived document and saved the changed file as a new revision, you must check the document out. When you check a document out, VIP ContentExplorer writes a copy of the file to your hard drive. You can then open the file, modify it as desired, and check the changed copy in as a new revision.

To check out a document, it must meet these conditions:

- It must be the most recent revision. While you can view earlier revisions (see page 65), you cannot check them out.
- You must be allowed to check the document out. A VIP DocManager Administrator can set who is and is not allowed to check out any document. If you see the Check Out action, as described in the procedure below, you can check the document out.
- The document must not be protected. A VIP DocManager Administrator or other authorized user can lock a document so no one can check it out and change it. When a document is locked, the Check Out action does not display for it.
- You cannot use offline DocLinks to check out documents.

**Note** This section and the procedure below describe checking out documents through a DocLink or OmniLink hit list. Depending on an option set by an administrator, you may also be able to check out documents from the VIP ContentView. See page 64.

**To check out documents through the hit list**

1. Using either a DocLink (see page 28) or OmniLink (see page 39), display a hit list that includes the document you want to check out.
2. Hover the pointer in the **Action** column for the document you want to check out, then select **Check Out**. This displays the **Check Out** dialog box.

   **Note**  Documents that are checked out or protected show an extra icon in the **Select** column. You cannot check those documents out.

![Check Out dialog box](image)

3. Select the **Lock Type** to apply to the document while you have it checked out. A **Read-Only Lock** lets other users view the document, but they cannot check it out and change it. An **Exclusive Lock** keeps users from changing or viewing the document.

   **Note**  Depending on a setting by a VIP DocManager Administrator, either lock type may be selected by default, and you may not be able to change it.

4. Browse to and select (or type) the **File Path** where VIP ContentExplorer should put the copy of the checked out file.

   **Note**  Your VIP DocManager Administrator may have set up a drive and directory location for all documents being checked out. If so, select this directory.

5. Type a **Comment** for the check out. This is optional. This is often the reason you are checking the document out.

6. To open the document immediately, check the **Open document** box. VIP ContentExplorer will then have the browser open the file using the application defined for its file type.

   If you don’t check **Open document**, the file is copied to the **File Path** location but not opened. You can open it later using any Windows method.

7. Click **Submit**.
Modifying a Document

Once you have a document checked out, you can change it as you would any other file of its type, using any application. (If you selected Open document during the check out, your browser opened it immediately using the application associated with its type.) Make any changes you want to make. When you’re finished, save and close the file. You can either save it using the same name and location, or change the name or directory. You’ll be able to specify the file to use when you check the document back in.

You can also make new annotations or modify existing ones by opening the document in the ContentViewer. How VIP ContentExplorer handles these annotations when a document is checked out depends on an option set by an administrator:

- If annotations are counted as a revision to the document, you must check the document back in as a new revision to save your changes. See “Adding Annotations as Revisions” on page 64 for the procedure to follow.
- If annotations are not considered a new revision of the document, you can save them as usual and they are added to the current head revision of the document. No new revision is created.

See Chapter 8 for more information about annotations.
Checking In a Document

Checking in a document submits an updated version of a document you’ve checked out. VIP DocManager captures and archives the new file, making it the current revision of the content object. Unless you are a VIP DocManager Administrator, you can only check in a document you have checked out. Administrators can check in a document that was checked out by a different user.

If you check out a document, then decide you do not want to check in a new revision, you can cancel the checkout, as described after the check in procedure.

*Note* Your ability to check in documents is controlled by the VIP DocManager Administrator.

To check in a document

1. Display a DocLink or OmniLink hit list that includes the document you want to check in. See page 28 for DocLinks or page 39 for OmniLinks.
2. Hover the pointer in the *Action* column for the document you want to check out, then select *Check In*. This displays the *Check In* dialog box.

   ![Check In Dialog Box]

3. Type the full path for the file you are checking in, or click *Browse* and select the file. This does *not* have to be the same path you checked the document out to.

4. Type a *Comment* for the check in. This is required. The comment displays in the revision list for the document (see page 65).

5. If you want to change any of the index values for the document, type the new values in the *Index List* fields.
6. Click **Submit** to check in the document.

   **Note**  If you try to check in a document that was checked out by another user, and you are not a DocManager Administrator, you will see an error message saying that you do not have the document locked.

**To cancel a check out**

1. Display a DocLink or OmniLink hit list that includes the document you want to check in. See page 28 for DocLinks or page 39 for OmniLinks.

2. Hover the pointer in the Action column for the document you want to check out, then select **Cancel Check Out**.
Adding Annotations as Revisions

Depending on a setting on the VIP DocManager server, you may be able to make annotations to a document through the VIP ContentViewer, then save the annotated document as a new revision. If this feature is enabled, follow the procedure below to make annotations and save them as a new revision.

Note: If another user has the document checked out, all existing annotations in it will appear “grayed out,” and the Annotation menu Check out option will be inactive. Only one user can have a document checked out at a time.

To save annotations as a new revision

1. Use any method from Chapter 4 (DocFolder, DocLink, or OmniLink) to open the desired document in the VIP ContentViewer.
2. On the Annotations menu, select Check out.
3. Use the viewer to make the annotations you want. See page 91 for directions on making annotations.
4. On the Annotations menu, select Save Annotations.
5. On the Annotations menu, select Check in.
6. On the Checkin comment dialog box, type a comment for the new revision and click OK.
7. Close the VIP ContentViewer.

Tip: If you select Check in from the Annotations menu without first saving your annotations, the ContentViewer asks if you want to save the annotations. If you select Yes, the annotations are saved, but the new revision is not checked in. Select Check in again to check in the new revision.

Note: If you try to close the ContentViewer after saving your annotations, but without checking in the new revision, VIP ContentExplorer asks if you want to check in the document or cancel the checkout.
   - If you click CheckIn, the Checkin comment dialog box opens. Type a checkin comment and click OK. The new annotations are saved and a new revision is created.
   - If you click Cancel Checkout, your annotations are not saved, and no new revision is created. The document reverts to the previous head revision.
**Viewing Document Revisions**

When a document is checked out and checked back in, a new revision of the document is saved, but the previous versions are also still stored on the VIP DocManager server. At times, you may want to see the history of changes to a document or view a previous version of the document. You can do both of these using the procedure below.

**To view a revision of a document**

1. Display a DocLink or OmniLink hit list that includes the document you want to check in. See page 28 for DocLinks or page 39 for OmniLinks.

2. In the hit list, click the number in the Rev column for the desired document. (You may have to scroll to the right to see the Rev column.) This displays a list of the document’s revisions.

   The document in the following figure has two revisions.

   ![Table of Revisions](table.png)

3. To open a revision of a document, click the Revision button in the Select column for the desired version.

   **Note** To open multiple revisions at once, check the box in the Select column for each revision you want, then click the View button.
Reverting to a Previous Document Revision

When you view a document, or check it out to make changes, you see the most recent version—the *head revision* (unless you specifically view an earlier revision, as described in the preceding section). At times, you may want to return to using an earlier revision of a document as the head revision instead of the most recent version. For example, someone may have changed the document in error, or the head revision of the file may have been corrupted. You can return to an earlier revision by *reverting* the document to it.

When you revert a document, the revision you revert to is saved as a new revision. Other revisions are not lost; they are still available through the document’s revision history. The revision you revert to appears in the revision list twice: once where it was first checked in, and again as the most recent revision. For example: a document has five revisions. You discover that the changes made in revisions 4 and 5 are incorrect and should not be there. You revert the document to revision 3. When you do this, a new revision, revision 6 of the document, is saved. It is identical to revision 3. Revisions 4 and 5 are still stored in VIP DocManager and shown in the revision list, but anyone viewing the document will see revision 6 and any future changes to the document will be based on it.

**To revert to a previous version of a document**

1. Display a DocLink or OmniLink hit list that includes the document you want to check in. See page 28 for DocLinks or page 39 for OmniLinks.
2. In the hit list, click the number in the *Rev* column for the desired document. (You may have to scroll to the right to see the *Rev* column.) This displays a list of the document’s revisions.

   The document in the following figure has two revisions.

<table>
<thead>
<tr>
<th>Select</th>
<th>Id</th>
<th>User Name</th>
<th>Comment</th>
<th>Type</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>AUTOUSER1</td>
<td>Small editing changes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. To revert to a previous version of the document, click the *Revert* button in the *Select* column. This displays the *Revert* dialog box.

4. Type a *Comment* for the reversion. This will be the comment for the new revision created when you revert.
5. Click *Submit*. 
Protecting Documents

If the current revision of a document should not be changed, for whatever reason, a VIP DocManager Administrator can protect it. When a document is protected, it cannot be checked out and updated.

An administrator can unprotect a protected document at any time.

**To protect or unprotect a document**

1. Log into the VIP DocManager server using an administrator user name.
2. Display a DocLink or OmniLink hit list that includes the document you want to check in. See page 28 for DocLinks or page 39 for OmniLinks.
3. If the document is not protected, hover the pointer over the Action column for it and select Protect. The Protected icon appears in the Select column.
4. If the document is protected, the Protected icon appears in the Select column. To remove the protection, hover the pointer over the Action column and select Unprotect.

**Note** You cannot protect a document that is currently checked out.
Chapter 7

The VIP ContentViewer

This chapter describes the VIP ContentViewer. VIP ContentExplorer uses the ContentViewer to display reports and images retrieved from the VIP DocManager server. This chapter includes an overview of the ContentViewer interface, then discusses these specific features:

- Comparing documents
- Changing the mouse mode
- Moving through a document
- Changing the document display:
  - Rotating an image right or left.
  - Image processing enhancements for viewing color images.
  - Zooming in to get a close up view of the image or zooming out to see more of the image at a reduced size.
  - Changing an AFP document’s resolution to improve display
  - Changing the text or background color for reports.
- Searching for text in a report.
- Performing an index search within a report. This feature is available only on iSeries VIP DocManager servers, and only if a search index has been defined for the DocClass.

Other features available from the ContentViewer—adding annotations to documents, printing documents, and so on—are covered in subsequent chapters.

Note: The full ContentViewer is available only when using ContentExplorer on a workstation. Mobile device users see a different viewer. See “The Mobile Device Document Viewer” on page 89.
VIP ContentView Overview

The VIP ContentView lets you display and work with host reports and images (documents). When you open a report or image in VIP ContentExplorer—through a DocFolder, a DocLink or OmniLink hit list, through a workflow item, or from a URL sent to you via e-mail—if it is one of the file types listed below, it is displayed in the ContentView.

VIP ContentExplorer sends captured report steam files and the following types of image files to the ContentView applet:

- TIF, TIFF, JPG, JPEG, GIF, BMP, CALS, AFP, PCL, and PDF

All other files are sent to a browser. The browser opens the file in its usual way for the file type. This is most often either an external viewer or a browser plug-in. For example, PCL reports may be sent to an external viewer such as SwiftView, while Microsoft Office documents (Word, Excel, etc.) and PDF files may be opened in a browser plug-in.

On tablet computers, you can open only files which open in the ContentView and some Microsoft Office files: Word documents, Excel spreadsheets, and PowerPoint presentations. The Office files are opened in a browser plug-in. A file of any other type displays a prompt asking you to select the application to use to view it.

The ContentView opens in a pop-up browser window. The size and location of this window is configurable. When you open a workflow item, it opens in a two-pane pop-up window, with its dynamic form on the left and the ContentView on the right.
The VIP ContentViewer Workspace

Here is an example of the VIP ContentViewer with an image file.

As you can see, the ContentViewer workspace consists of menus and a toolbar at the top, with the report or image displayed below.
VIP ContentViewer Menus

The VIP ContentViewer includes eight menus for text reports and six for images, PDF reports, or PCL reports. Their options are described in the following sections.

**Tip**  
You can use the keyboard to navigate the menus (by pressing **ALT** plus the underlined letter for the menu you want), or use the **CTRL** key equivalents for those menu options that have them (such as **CTRL+S** to **Send** the file). However, before doing so, you must click somewhere in the ContentViewer.

**Note**  
Depending on a setting on the VIP DocManager server, text reports may be converted to PDF files when you display them with VIP ContentExplorer. If this is done, you can use the features described below for “images” with these files, not the features listed for “text reports.”

**File**

The File menu contains commands which affect the entire displayed document. See page 107 for more information.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send</td>
<td>E-mails entire document or specified pages of document via the local e-mail client.</td>
</tr>
<tr>
<td>Send Without</td>
<td>E-mails the entire document in its original format, without any annotations made in the ContentViewer.</td>
</tr>
<tr>
<td>Annotations</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>Prints document to a local printer.</td>
</tr>
<tr>
<td>Save as Image</td>
<td>Available for all documents. Saves file as an image.</td>
</tr>
<tr>
<td>Note</td>
<td>Text reports that contain critical annotations can only be saved as images.</td>
</tr>
<tr>
<td>Save as Text</td>
<td>Available only for text reports. Saves file as text.</td>
</tr>
</tbody>
</table>

**GoTo**

The GoTo menu contains commands to navigate documents.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Page</td>
<td>Displays the next page in the document.</td>
</tr>
<tr>
<td>Previous Page</td>
<td>Displays the previous page in the document.</td>
</tr>
<tr>
<td>Top</td>
<td>Displays the first page of the document.</td>
</tr>
<tr>
<td>Bottom</td>
<td>Displays the last page of the document.</td>
</tr>
<tr>
<td>Go To</td>
<td>Displays a specified page. You enter the page number to go to.</td>
</tr>
</tbody>
</table>
Notes
The Notes menu command lets you attach a note to the current page. This feature is
designed to replicate attaching paper notes to a document or writing directly on a
document. See page 91 for more information.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work with notes for this page</td>
<td>Displays notes for the current page and lets you add or remove a text note. Viewing and deleting text notes requires correct permissions.</td>
</tr>
<tr>
<td>Work with notes for all pages</td>
<td>Lets you display, add, or remove text notes for any page in the document. Viewing and deleting text notes requires correct permissions.</td>
</tr>
</tbody>
</table>

Annotations
The Annotations menu options are used to apply or remove special effects for displayed
text. Except as noted, see page 91 for more information.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Annotations</td>
<td>Shows or hides annotations applied to a document.</td>
</tr>
<tr>
<td>Save Annotations</td>
<td>Saves annotations applied to a document.</td>
</tr>
<tr>
<td>Check out</td>
<td>Available for images controlled by revision control. See Chapter page 59.</td>
</tr>
<tr>
<td>Check in</td>
<td>Available for images controlled by revision control. See Chapter page 62.</td>
</tr>
<tr>
<td>Blackout</td>
<td>Covers an area you select with an opaque colored box, preventing the text from being read. You can associate text with the blacked-out area. This is a critical annotation.</td>
</tr>
<tr>
<td>Highlight</td>
<td>Highlights an area with a transparent colored box. You can associate text with the highlighted area.</td>
</tr>
<tr>
<td>Sticky Note</td>
<td>Attaches a text note to the current page.</td>
</tr>
<tr>
<td>Rubber Stamp</td>
<td>Adds a rubber stamp to the current page. This is a critical annotation.</td>
</tr>
<tr>
<td>Attach File</td>
<td>Adds a file as an attachment to the current page.</td>
</tr>
<tr>
<td>Colors</td>
<td>Lets you select the color for the text used with blackouts, highlights, and sticky notes.</td>
</tr>
<tr>
<td>Delete Annotation</td>
<td>Deletes the selected normal annotation. You can also delete an annotation with the Delete key.</td>
</tr>
</tbody>
</table>
**View**

The options on the View menu enable you to modify the orientation and magnification of the document. The features related to orientation are available for images only, not reports.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate Clockwise</td>
<td>Rotates the current page display right by 90 degrees. (Images only.)</td>
</tr>
<tr>
<td>Rotate Counter Clockwise</td>
<td>Rotates the current page display left by 90 degrees. (Images only.)</td>
</tr>
<tr>
<td>Rotate Angle</td>
<td>Rotates the current page display by a specified angle. (Images only.)</td>
</tr>
<tr>
<td>AFP DPI</td>
<td>Selects either 200 DPI or 300 DPI resolution for AFP file content. Choosing the correct resolution can improve text layout appearance in complex tables. (Images only.)</td>
</tr>
</tbody>
</table>
| Image Processing  | Options to enhance images: (Images only.)  
| Deskew            |—corrects images that became misaligned during scanning. |
| Despeckle         |—removes dots or speckles from an image. |
| Fit To Page       | Changes the display size so the entire page just fits in the ContentViewer. |
| Fit To Width      | Changes the display size so the page width just fits in the ContentViewer. |
| Fit To Height     | Changes the display size so the page height just fits in the ContentViewer. |
| Zoom In           | Zooms the display in. The amount of zoom differs depending on the document type. |
| Zoom Out          | Zooms the display out. The amount of zoom differs depending on the document type. |
| Enter Zoom Level  | Displays a dialog box where you can enter the zoom setting (percentage of the image’s original size) you want. |
| Zoom 25%          | Changes the display size to 25% of the original size. |
| Zoom 50%          | Changes the display size to 50% of the original size. |
| Zoom 100%         | Changes the display size to the original size. |
| Zoom 200%         | Changes the display size to 200% of the original size. |
| Zoom 500%         | Changes the display size to 500% of the original size. |
Help
The Help menu lets you see copyright and version number information for the ContentView.

Search
The Search menu is available for text report files only.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequential Search</td>
<td>Searches the report for the text you enter, starting on the current page.</td>
</tr>
<tr>
<td>Indexed Search</td>
<td>Available only for reports on an iSeries VIP DocManager server. Searches a report index in the current report for a value you enter.</td>
</tr>
<tr>
<td>Go to Next Hit</td>
<td>Finds the next matching value.</td>
</tr>
<tr>
<td>Go to Previous Hit</td>
<td>Finds the previous matching value.</td>
</tr>
</tbody>
</table>

Options
The Options menu is available for report files only.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Color</td>
<td>Selects the text color for the report.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Selects the background color for the report.</td>
</tr>
<tr>
<td>Index Highlight Color</td>
<td>Selects the highlight color for indices.</td>
</tr>
<tr>
<td>Green Bar</td>
<td>Displays the report on alternating bars of green and the selected background color (white by default).</td>
</tr>
<tr>
<td>Blue Bar</td>
<td>Displays the report on alternating bars of blue and the selected background color (white by default).</td>
</tr>
<tr>
<td>Solid</td>
<td>Clears green or blue bar formatting and displays the document with a solid background.</td>
</tr>
</tbody>
</table>

VIP ContentViewer Toolbar
The VIP ContentViewer toolbar provides an alternative way to access common functions. Almost all of the features available on the toolbar are also available through the menus.

Note
Some buttons are only active, or only visible, for certain types of documents.

Saves report as text.

Prints the current document to a local printer.
Sends the report via e-mail, with annotations.

Sets the mouse to pan and zoom mode.

Sets the mouse to select and scroll mode.

Zooms in to magnify the magnification of the current document in the viewer. The amount of zoom differs depending on the document type.

Zooms out to reduce the magnification of the current document in the viewer. The amount of zoom differs depending on the document type.

Enlarges or reduces the image or report to fit the page into the display window.

Enlarges or reduces the image to fit the page width into the display window.

Enlarges or reduces the image to fit the page height into the display window.

Rotates an image clockwise by 90 degrees.

Rotates an image counterclockwise by 90 degrees.

Displays the first page in the report.

Displays the last page in the report.

Displays the previous page in the report.

Displays the next page in the report.

Displays a specific page in the report.

Lets you view and add text notes to current page. If there are any notes on the page, there is a green checkmark on the button.

Shows or hides non-critical annotations (highlights, sticky notes, file attachments, and rubber stamps).

Creates a blackout annotation. See “Blackout Annotations” on page 100
Creates a highlight annotation. See “Highlight Annotations” on page 101.

Creates a sticky note annotation. See “Sticky Notes” on page 102.

Creates a rubber stamp annotation. See “Rubber Stamp” on page 104.

Attaches a file to the page. See “Attach File” on page 104.

Displays a list of bookmarked annotations. Select the bookmark to go to from the list.

Generates a URL for the displayed document.

Displays logging information.

For a PDF or PCL file, opens the file in the external viewer for its file type. You may want to use this if the file is not displaying correctly in the ContentViewer. This button is not active for any other type of file.
Comparing Documents

If you open two-to-four documents at once using the compare icon, as described in Chapter 4, the documents open side-by-side in a single browser window. The window is split into either two panes or four panes: each pane is a complete VIP ContentView window, with all the menus and toolbar icons. If you open three documents for comparison, the lower-right pane is empty.

At the top of the window, above the ContentView panes, there’s a selection bar that looks like this:

![Selection Bar](image)

You can use this area to do the following:

- To change the display to show just one of the documents, click the square corresponding to its pane in the left-hand group.
- To change the display to show just two documents, click the squares corresponding to their panes in the right-hand group. (This does not appear if you opened only two documents.)
- To return to showing all documents being compared, click **Show All**.
- To clear all checked boxes without changing the documents shown, click **Uncheck All**.

Other than these options for changing the documents shown, you work with the open documents as you would in a single ContentView window.
Changing the Mouse Mode

The ContentViewer offers two different modes for using the mouse. They are:

- **Pan and Mouse Zoom** – If the entire current page does not fit in the window, you can click and drag to move around the page. The center wheel on the mouse zooms in or out, without moving the display—whatever was centered before zooming will still be centered afterward.

- **Select to Zoom and Mouse Scroll** – You can click and drag around a displayed area to zoom in on it, as described in “Rubberband Zooming” on page 81. Double-click in the document window to return to the currently set zoom level. The center wheel on the mouse scrolls through the entire document.

**Tip** When using this mode, you may want to set the zoom level to “fit to page.” That way, you can see the entire page, use the mouse to zoom in on the information you want, then double-click to return to the entire page.

To select the mouse mode, click the indicated toolbar button. There is more information on using these two modes in “Moving Through the Document” on page 80 and “Zooming the Document Display” on page 81.
Moving Through the Document

The ContentViewer shows only one page—or part of a page—of a document at a time. You can choose from several ways to move around the file:

- You can use the scroll bars at the right and bottom of the viewer to scroll through an entire image file. This does not work for a report; in reports, the scroll bar scrolls only on the current page.
- You can use the PAGE DOWN/PAGE UP keys on the keyboard to go to the next or previous page of the document.
- You can scroll around the current page using the arrow keys on the keyboard.
- If you are in Select to Zoom and Mouse Scroll mode, you can use the center wheel of the mouse to scroll through the file (see “Changing the Mouse Mode” on page 79).
- If you are in Pan and Mouse Zoom mode, you can click and drag to see different parts of the current page (see “Changing the Mouse Mode” on page 79).
- You can use the commands on the GoTo menu or the toolbar buttons to change the page shown.

To do this: Use this command: Or this button:

Go to the next page. Next Page
Go to the previous page. Previous page
Go to the first page of the document. Top
Go to the last page of the document. Bottom
Go to a specific page of the document. GoTo
Go to a bookmarked location (see page 97) Then select the desired bookmark.

There is no menu command.

Except as noted, all of these methods work with either text reports or images.

**Tip** When using the keyboard to move around a document, the keys may suddenly stop working. If this happens, simply click anywhere in the document window. With certain combinations of browser version and Java version, the document window may lose focus on occasion, even though you are working in it. As this depends entirely on other software, there is no way for ContentExplorer to prevent it.
Changing the Document Display

To make an image or report easier to read, you can modify how it is displayed in the ContentViewer. The following sections describe how you can change the document’s display size or orientation, and correct certain display problems. These features affect only how the document is displayed (and in some cases, printed). They do not modify the report or image stored in VIP DocManager.

Zooming the Document Display

When viewing documents, you can use three methods to zoom-in to get a close-up view of detailed information on a document, or to zoom-out for an overview of a document’s layout: rubberband zooming, mouse zooming, and fixed magnification zooming.

Note  All zoom features affect only document display, not printing.

Rubberband Zooming

To enlarge the document display to show only a particular area, just drag with the mouse to outline the desired part of the page. The display will magnify to show only that area. To return the display to the size it was before you used rubberband zooming, double-click anywhere on the document page.

You must be in Select to Zoom and Mouse Scroll mode to use this feature. See “Changing the Mouse Mode” on page 79.

Note  Zooming may be more or less than you expect in order to match the area you select to the proportions of the viewer window.

Mouse Zooming

If you are in Pan and Mouse Zoom mode, the center wheel on the mouse zooms the display in or out, without moving the display—whatever was centered before zooming will still be centered afterward. See “Changing the Mouse Mode” on page 79.

Fixed Magnification Zooming

You can use either the View menu or toolbar buttons to enlarge or reduce the document display in various ways.

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Use this command:</th>
<th>Or this button:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enlarge or reduce the display to fit the entire page into the window.</td>
<td>Fit to Page</td>
<td></td>
</tr>
<tr>
<td>Enlarge or reduce the display to fit the page width into the window.</td>
<td>Fit to Width</td>
<td></td>
</tr>
</tbody>
</table>
Rotating an Image

You can rotate images displayed in the ContentViewer in three ways.

Note These features are not available for text reports.

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Use this command:</th>
<th>Or this button:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enlarge or reduce the display to fit the page height into the window.</td>
<td>Fit to Height</td>
<td></td>
</tr>
<tr>
<td>Zoom the display in. The amount of zoom differs depending on the document type.</td>
<td>Zoom In</td>
<td></td>
</tr>
<tr>
<td>Zoom the display out. The amount of zoom differs depending on the document type.</td>
<td>Zoom Out</td>
<td></td>
</tr>
<tr>
<td>Zoom to a particular magnification.</td>
<td>Enter Zoom Level, then type percentage and click OK.</td>
<td>None</td>
</tr>
<tr>
<td>Display the document at 25 percent of actual size.</td>
<td>Zoom 25%</td>
<td>None</td>
</tr>
<tr>
<td>Display the document at 50 percent of actual size.</td>
<td>Zoom 50%</td>
<td>None</td>
</tr>
<tr>
<td>Display the document at 100 percent of actual size.</td>
<td>Zoom 100%</td>
<td>None</td>
</tr>
<tr>
<td>Display the document at 200 percent of actual size.</td>
<td>Zoom 200%</td>
<td>None</td>
</tr>
<tr>
<td>Display the document at 500 percent of actual size.</td>
<td>Zoom 500%</td>
<td>None</td>
</tr>
</tbody>
</table>

Rotating an Image

You can rotate images displayed in the ContentViewer in three ways.

Note These features are not available for text reports.

If you want to:  
Do this:

- Rotate the image 90 degrees clockwise
  - Click the Rotate Clockwise button or select Rotate Clockwise from the View menu.

- Rotate the image 90 degrees counterclockwise
  - Click the Rotate Counterclockwise button or select Rotate Counterclockwise from the View menu.

- Rotate the image a specific amount
  - From the View menu, select Rotate Angle. Type the number of degrees to rotate the image and click OK. Positive numbers rotate the image clockwise; negative numbers rotate it counterclockwise.

Rotating an image affects both the display and how the image will print.
Changing the Document Display

Image Processing

The two Image Processing commands on the View menu enable you to correct certain problems with color images.

Note These features are not available for text reports.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deskew</td>
<td>This feature corrects the display for documents that become misaligned during scanning, due to the mechanical feeding action of the scanner. The deskew feature calculates and corrects skew angles up to 12 degrees.</td>
</tr>
<tr>
<td>Despeckle</td>
<td>This feature removes unwanted dots or speckles from an image. Speckles are groups of black pixels surrounded by white pixels, or white pixels surrounded by black pixels.</td>
</tr>
</tbody>
</table>

Both deskew and despeckle affect both the display and how the image will print.

Changing AFP Document Resolution

VIP ContentExplorer can display AFP report files using either 200 or 300 DPI resolution. Changing the resolution can help if there are problems with the report display, especially with text layout in complex tables.

To change the AFP resolution, from the View menu, select **AFP DPI**, then select either **200** or **300**.

Note The default resolution is set by a VIP DocManager administrator. If all of your AFP files use the same resolution, and the default is set correctly, you should not need to use this option.

Working with Color

For text reports only, you can change the colors VIP ContentExplorer uses to display the text and the background, or make it appear as if it is displayed on report paper with color bars. The features to do this are all on the Options menu, which appears only for text reports. Except as noted, these features affect only the display, not printing.

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the text color</td>
<td>From the Options menu, select <strong>Text Color</strong>. On the <strong>Text Color</strong> dialog, select the color you want and click <strong>OK</strong>. The color you choose is used for both display and printing.</td>
</tr>
<tr>
<td>Change the background color</td>
<td>From the Options menu, select <strong>Background Color</strong>. On the <strong>Background Color</strong> dialog, select the color you want and click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
To do this:  

- Display alternating pale green bars on the background
- Display alternating pale blue bars on the background
- Remove the background green or blue bars

Do this:  

- From the Options menu, select Green Bar.
- From the Options menu, select Blue Bar.
- From the Options menu, select Solid. The background returns to the selected background color.
Opening Images in Another Viewer

Some images may not display perfectly in the ContentViewer. If you want to see the file you are viewing in its native viewer (for example, Adobe® Reader® for a PDF file), you can click the External Viewer button on the toolbar. This opens the current image in a separate window using the program that your browser has associated with the file type. When you open an image in an external viewer, you will not see any annotations that have been added in the ContentViewer, and any changes or annotations you make in the external viewer (if it allows any) will not be saved or available through VIP ContentExplorer.

Opening the image in an external viewer does not close the ContentViewer. You can continue to work in the ContentViewer while you view the image in the other window.
Report Sequential Search

A sequential search looks through the text in a report, starting on the displayed page, and shows you the next occurrence of the text you are searching for. Options let you decide the direction of the search, whether to match only whole words, and more. Sequential search is available only for reports, not for images.

To perform a sequential search

1. Open the report in the ContentViewer.
2. From the Search menu, select **Sequential search**.
3. Type the text to **Search for**. You must type the exact text; wildcards are not supported.
4. To consider case in the search, check the **Match Case** box. To find matches regardless of case, clear the **Match Case** box. For example, searching for **Test** would match **TEST** and **test** if the box is cleared, but not if it is checked.
5. To match only entire words, not parts of words, check **Match Whole Word**. For example, searching for **Test** would match **Tests** and **Testing** if the box is cleared, but not if it is checked.
6. check **Wrap Around Search** if you want your search to continue on page 1 after it reaches the end of the report, or clear the box to have it stop when it reaches the end. (If you are searching upwards in the report, if the box is checked it will continue with the last page after reaching the first.)
7. Select **Up** to search backwards from the current page or **Down** to search forward through the report.
8. Click **OK** to start the search. VIP ContentExplorer finds the first match for your entry (in the direction you’ve chosen) and shows it in the viewer window, with the matching text highlighted.

9. To find the next occurrence of the text, from the Search menu, select **Go to Next Hit**.

10. To return to the previous match, from the Search menu, select go to **Previous Hit**.
Report Index Search

On an iSeries VIP DocManager server, administrators can define indices to use for searching open reports. These indices are defined separately for each DocClass. In VIP ContentExplorer, you can use these report indices to search for specific content in an open report.

*Note* Report Index Search functionality is only available for reports on an iSeries server.

Each report index defines a specific position in a report or on each page of the report. Text in the index position is referred to as the index value. You use the ContentViewer to search a report for specific index values.

To perform a report index search

1. Open the report in the ContentViewer.
2. From the Search menu, select Indexed search.
3. In the Query list field, double-click the report index to search.
4. In the Search for field, type the text to look for. You can use an asterisk (*) as a wildcard character.
5. Click the OK button.
   
   ContentViewer displays the page containing the first match.
6. To locate the next match, click Go to the Next Hit on the Search menu.
7. To go back to a previous match, click Go to the Previous Hit on the Search menu.
The Mobile Device Document Viewer

On a mobile device, VIP ContentExplorer uses a different document viewer than on a workstation. This mobile viewer has more limited capabilities: you can view reports and supported image formats, and add or delete some types of annotations, but you cannot perform other functions, such as printing or emailing the document.

When you open a document in the mobile viewer, the text and images in the document appear first, followed by any annotations added using ContentExplorer. If there are blackouts or rubber stamps, the document content and annotations appear at the same time.

You can perform these actions in the mobile viewer:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Perform this action</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move around the current page</td>
<td>Drag with one finger</td>
<td>None</td>
</tr>
<tr>
<td>Change the zoom level</td>
<td>Tap the Zoom In or Zoom Out icon.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On iOS devices, you can also pinch in or out with two fingers.</td>
<td></td>
</tr>
<tr>
<td>Go to the next page</td>
<td>Tap the Next Page icon</td>
<td></td>
</tr>
<tr>
<td>Go to the previous page</td>
<td>Tap the Previous Page icon</td>
<td></td>
</tr>
<tr>
<td>Go to a particular page</td>
<td>Type the page number in the first field, then tap the Goto Page icon</td>
<td></td>
</tr>
<tr>
<td>Close the document</td>
<td>Tap the Close icon</td>
<td></td>
</tr>
<tr>
<td>Stop the page from loading</td>
<td>Tap the Stop icon.</td>
<td></td>
</tr>
</tbody>
</table>

Note: You might want to do this if you went to the wrong page, or if a page is taking a very long time to load.

For information on working with annotations on mobile devices, see 8, “Notes and Annotations.”
Chapter 8

Notes and Annotations

VIP ContentExplorer allows users to use bookmarks, create text notes, highlight or black out text, and attach files to existing documents without altering the original document. The notes, and annotations are saved in a separate file and point to the original report or image. Each annotation may be marked and used as a bookmark to easily locate pages in a document (see page 80).

This chapter describes how to:

- Attach and view text notes
- Highlight text
- Black out text
- Place sticky notes on documents
- Attach files to documents
- Place electronic rubber stamp annotations
- Mark an annotation as a bookmark so you can return to it easily
Notes and Annotations Overview

VIP ContentExplorer offers two ways for you to add content to an archived document:

- You can add one or more text notes to any page in the report. To see the notes for a page, you must open the Text Notes dialog. For more information about text notes, see page 93.

- You can add any of several types of annotations—highlights, blackouts, and so on. Each annotation is associated with a particular location on a page, and you can view annotations directly on the document page. For more information about annotations, including a description of each type, see page 96.

You can mark any text note or annotation as a bookmark, which lets you select it from a list to go directly to its location in the document.

If a document is under revision control, you may need to check it out before you can make or change annotations, and your annotations may be saved as a new revision of the document. See page 64.

Note: What you can do with each type of note and annotation depends on options set by an administrator. You may not be able to see some types of annotations, may see other types, but not be allowed to edit or add them, and may be able to perform any action on other types.

Notes and Annotations on Mobile Devices

On a mobile device, you can perform some, but not all, of the annotation functions possible in ContentExplorer on a workstation. You can do the following:

- Add a blackout, highlight, or sticky note annotation.
- Enter text for a sticky note annotation.
- Delete an annotation.
- Show or hide annotations.

No other annotation functions are possible on smart phone or tablet computers.

The procedures for working with annotations on a mobile device are included in the same sections as the corresponding workstation procedures. If a section does not give a procedure for mobile devices, you cannot perform that action on a mobile device.
Text Notes

You can add as many notes as you want to any page in an archived document. Each note is associated with the page displayed when you enter it, and is readable only when that page is displayed.

Notes are saved as long as the document remains archived, unless you delete them. A note can be as long as desired.

Unlike annotations, there is no visible mark on the document page to show there is a note entered for it. To see notes, you must display the Text Note dialog box, as described below.

Working with Text Notes

You can view, add, or delete text notes using the Notes menu. There are options to work with just the notes for this page, or with notes on any page in the document.

Note You cannot change a note once it has been created and saved.

To work with text notes for the current page

1. Display the document page you want to view the notes for.
2. Click the Work with Page Notes button or, from the Notes menu, select Work with notes for this page. (If there are already notes on the page, the button has a green checkmark on it.)

The Text Note dialog box appears with the notes for the current page displayed. The first line of each note includes the logon ID of the user who added the note and when the note was saved. The notes are in the order they were added. Scroll the note list as necessary to see all notes.
3. To add a note:
   - In the input box at the bottom of the Text Note dialog box, type the text.
   - If you want to mark the note as a bookmark (see page 97), check the **Bookmark** box.
   - Click **Add**.

   The date and time the note was created, and your logon ID, are saved with the note.

4. To delete a note:
   - Select the note to delete.
   - Click **Delete**.

5. When you are finished, click **OK** to save your changes (notes you’ve added or deleted) and close the dialog box. If you click **Cancel**, the dialog box closes and any changes are not saved.

To view text notes for any page

*Note* You cannot delete a text note when you are working with notes for all pages.

1. From the Notes menu, select **Work with notes for all pages**.
2. Select the page containing the note you want to see. Only pages that have notes are listed.

   ![Notes for selected page](image)

   The notes for the selected page appear. The first line of each note includes the logon ID of the user who added the note and when the note was saved. The notes are in the order they were added. Scroll the note list as necessary to see all notes.
3. To add a note for the selected page:
   - In the input box at the bottom of the Text Note dialog box, type the text.
   - If you want to mark the note as a bookmark (see page 97), check the Bookmark box.
   - Click Add.
   The date and time the note was created, and your logon ID, are saved with the note.

4. To switch to a different page, select it in the list.

5. When you are finished, click OK to save any notes you’ve added and close the dialog box. If you click Cancel, the dialog box closes and any notes are not saved.
Annotations

Unlike text notes, which are not shown in the ContentViewer display of a document page, annotations are associated with a specific location or area of a page, and can be shown in the ContentViewer. There are five types of annotations: blackout, highlight, sticky note, file attachment, and rubber stamp. For more information about these types, see page 99. Annotations are very flexible: you can choose whether or not to display or print them (except for blackouts), choose colors for and add text to most types, and use them as bookmarks to help you find your way around documents.

The following sections describe topics and procedures that apply to annotations of more than one type: showing and hiding annotations in a document, setting the colors they use, using them as bookmarks, saving them, and printing them. Instructions for adding individual annotations to a document start on page 99.

Showing and Hiding Annotations

Annotations are associated with either a specific location on a page (sticky notes and file attachments) or a selected area of a page (blackouts, highlights, sticky notes, and rubber stamps). Since you may want to view a document page without annotations cluttering the display, you can choose whether or not to show them. Here are examples of a page display with annotations (in this case, a highlight area) shown and hidden.

Note

As shown, blackout annotations always display, whether Show Annotations is selected or not. Rubber stamps also always display.

To switch between displaying and hiding annotations, select Show Annotations from the Annotations menu or click the Show Annotations button.

On a mobile device, to switch between displaying and hiding annotations, tap the Show Annotations icon.

If the annotations in a document appear “grayed out,” it means the document is under revision control, changes to annotations are counted as new revisions, and you do not have the document checked out. In this condition, you cannot change existing annotations or create new ones. See page 64.
Selecting Annotation Display Colors

By default, blackout annotations are black, while highlight and sticky note annotations are a bright yellow. You can select different colors for any or all of these types of annotations. The color you select applies only to annotations you create after setting it; it does not change the color of existing annotations (you can edit an annotation if you want to change its color). You can save the color so it will be used on this workstation unless you change it again, or set the color so it is used only for the current viewing session. If you set it for only the current session, then closing and re-opening the document, or opening a different document, will return the color selection to its default.

To set annotation colors

1. Select Colors from the Annotations menu, then select Blackout, Highlight, or Sticky Note to set the color for that type of annotation.
2. Select from the 48 basic colors shown, or define a custom color for the selected annotation type.
3. Do one of the following:
   - To set this color for just this session with this document, click OK.
   - To save this color so it will be used for all annotations of this type on this workstation until you change it, click Save.

Bookmarks

You can define any annotation as a bookmark. After you have done so, you can go directly to that annotation from anywhere in the document. You can create and use bookmarks only from a workstation, not from a mobile device.

Defining Bookmarks

To mark an annotation as a bookmark, create it as described in the section for its annotation type, as described later in this chapter, and be sure to check the Bookmark box on its dialog box. You can also edit the annotation and check the Bookmark box. Be sure to save annotations after creating or editing a bookmark.
The only exception to this is rubber stamps. To use a rubber stamp as a bookmark, the rubber stamp template you use must be defined as a bookmark. You cannot mark a rubber stamp as a bookmark when adding it to a document.

**Going to a Bookmark**

To go to a bookmark, you display a list of the bookmarks in the current document, then pick the one you want. For each bookmark, the list includes an icon showing the type of annotation and the text associated with the annotation. For highlight, blackout, and sticky note annotations, this is the first 80 characters of the annotation’s text. For attached files, it is the name of the file. There is no text for a rubber stamp.

**To go to a bookmarked annotation**

1. Click the **Bookmark** toolbar button. The bookmarks in the document are listed beneath the button.
2. Click the bookmark you want. The display changes so the bookmark annotation is at the top of the window.

**Saving Annotations**

VIP ContentExplorer does not automatically save an annotation when you create or edit it on a workstation. You must save the annotations on each page before moving to another page or closing the document. To save the annotations on the current page:

- From the Annotations menu, select **Save Annotations**.

If you try to move to another page without saving new or changed annotations on the current page, VIP ContentExplorer asks if you want to save the annotations. Click **Yes** to save them.

If you try to close the document without saving annotations, VIP ContentExplorer reminds you that you have not saved them. Click **Cancel** to keep the document open so you can save your annotations.

On a mobile device, you save each annotation as you create it.

**Note** When you delete an annotation, it is removed immediately. You do not have to save annotations after deleting an annotation.
Printing Annotations

A report may be printed with or without the associated annotations. To print a report that includes annotations, you must have access to a local or network printer capable of printing graphics.

To print a report with annotations

1. Display the annotations for the report using the Show Annotations command in the ContentViewer.
2. Click the Print command on the File menu to print the report with annotations.

To print a report without annotations

1. Hide the annotations for the report using the Show Annotations command in the ContentViewer.
2. Click the Print command on the File menu to print the report without annotations.

Note For documents that contain blackout annotations, the selected text is always blacked out when the report is printed, regardless of whether annotations are hidden or displayed.

Individual Annotations

There are five types of annotations:

- **Blackout** — an opaque colored box that covers a selected area of the page, preventing any user from seeing text or images under it. You can enter text that users can see when the cursor is over the blackout.
- **Highlight** — a transparent colored box that covers a selected area of the page. You can enter text to appear in the box.
- **Sticky Note** — a text note that appears as a small note icon at the selected location.
- **Attached File** — any type of related file. Users can open the file by clicking the attachment icon.
- **Rubber Stamp** — a simulated stamp. A rubber stamp can contain a bitmap image, up to five text fields, and a field for a user’s signature.

You can view and work with all types of annotations on a workstation. On a mobile device, you can place blackouts, highlights, and sticky notes. You can also see rubber stamps, but cannot add them. You cannot see or work with attached files on a mobile device.

The following sections describe how to create and work with each of these types.
Blackout Annotations

A blackout annotation is an opaque colored box that covers a selected area of the page, preventing any user from seeing text or images under it. A blackout annotation is always displayed, whether Show Annotations is selected or not.

You can add text to a blackout, but it is not shown on the document page. To see the text, you must hover the cursor over the blackout area. The text is also shown in the bookmark list if you make the blackout a bookmark; see page 97.

You can select the color to use for the blackout area—the default is black. You can change the color for all blackouts you enter while you have a document open (see page 97) or set the color for individual blackouts, as described in the procedure below.

You can create and delete blackouts on both workstations and mobile devices. You cannot add text to a blackout, or read the text for a blackout, using a mobile device.

To create a blackout annotation on a workstation

1. Select the Blackout command from the Annotations menu, or click the Blackout toolbar button.
2. Click and drag around the area to black out. A rectangle appears over the selected area. When you release the mouse button, the area is blacked out.
3. Double-click in the blackout area to open the Extended blackout dialog box.
4. Type any text to associate with the blacked-out area.
5. If you want to mark the blackout as a bookmark (see page 97), check the Bookmark box.
6. To change the color of the blackout, click Background Color. On the Color Chooser dialog box, select the color you want and click OK.
7. Click OK to return to the document.
8. To save the annotation, from the Annotations menu, click Save Annotations.

To delete a blackout annotation on a workstation

- Click the blacked-out area to select it, then press the Delete key.

To create a blackout annotation on a mobile device

1. Tap the Blackout icon.
2. Using one finger, drag from the top-left to the bottom-right corner of the area to blackout.
3. Tap OK to save the blackout.

To delete a blackout on a mobile device

1. Tap the Delete icon.
2. Tap the blackout to delete.
3. Tap **OK**.

**Highlight Annotations**

A highlight annotation is a colored box that covers a selected area of the page. By default, the box is transparent so you can see the text or image beneath it, but you can make it opaque. You can add text to a highlight; it is shown in the highlight area.

You can select the color to use for the highlight area—the default is yellow. You can change the color for all highlights you enter while you have a document open (see page 97) or set the color for individual highlights, as described in the procedure below. You can also set the text color and font for any text you enter.

You can create and delete highlights on both workstations and mobile devices. You cannot add text or set any other characteristics for a highlight using a mobile device.

**To create a highlight annotation on a workstation**

**Tip** You can select the color to use for the highlight area. See page 97.

1. Select the **Highlight** command from the Annotations menu, or click the **Highlight** toolbar button.

2. Click and drag around the area to highlight. A rectangle appears over the selected area. When you release the mouse button, the area is highlighted.

3. To add text to the highlight or set other characteristics:
   - Double-click in the highlight area to display the *Extended Highlight* dialog box.
• Type the text for the note.
• Select the Display Text check box to display the text.
• Select the alignment, background color, and font attributes you want. You must select Display Text before you can do this.
• If you want the highlight to be opaque, select Opaque in the Background Color box.
• If you want to mark the highlight as a bookmark (see page 97), check the Bookmark box.

4. Click the OK button to return to the document.
5. To save the annotation, from the Annotations menu, click Save Annotations.

   Tip In the highlight, text does not wrap to the next line automatically. To enter multi-line text, you must press Enter while typing the text.

   Tip The text will not display outside the highlight area. If the text is too long to fit in the highlight, either adjust the font size or drag an edge of the highlight to enlarge it.

To delete a highlight on a workstation
• Click the highlight annotation to select it, then press the Delete key.

To create a highlight on a mobile device

1. Tap the Highlight icon.
2. With one finger, drag from the top-left to the bottom-right corner of the area to highlight.
3. Tap OK to save the highlight.

To delete a highlight on a mobile device

1. Tap the Delete icon.
2. Tap the highlight to delete.
3. Tap OK.

Sticky Notes
The Sticky Note command attaches a text note to a specific location on the current page. You can create and delete sticky notes on both workstations and mobile devices.

To attach a sticky note on a workstation

   Tip You can select the color to use for the note. See page 97.
1. Select the **Sticky Note** command from the Annotations menu or click the **Sticky Note** toolbar button.

2. Click the location to insert the sticky note to display the **Sticky Note** dialog box.

3. In the input box, type the text for the note.

4. If you want to mark the note as a bookmark (see page 97), check the **Bookmark** box.

5. Click the **OK** button to attach the note.

   The sticky note appears as a yellow on the page. Click the note to open it and display the note text. To close an open note, click its upper left corner.

6. To save the annotation, from the Annotations menu, click **Save Annotations**.

**To delete a sticky note on a workstation**

- Click the note to select it, then press the **Delete** key.

**To create a sticky note on a mobile device**

1. Tap the **Note** icon.

2. Drag with one finger from the top-left to the bottom-right corner of the area for the note.

3. Type the note text and tap **OK**.

4. Tap **OK**.

**To open or close a note on a mobile device**

- Double-tap the note to open it and see the note text. Double-tap it again to collapse it.

**To delete a sticky note on a mobile device**

1. Tap the **Delete** icon.

2. Tap the sticky note to delete.

3. Tap **OK**.
**Attach File**

The Attach File command lets you insert a file as an attachment on the current page.

**To attach a file to a document page**

1. Select the Attach File command from the Annotations menu or click the Attach File toolbar button. The Select File Annotation dialog box opens.

   ![Select File Annotation dialog box]

2. Type the path and name of the file to attach or click the Browse button and select the file to attach.

3. If you want to mark the file attachment as a bookmark (see page 97), check the Bookmark box.

4. Click the OK button.

5. Click the location where you want to attach the file. It must be on the current page.

   The attachment appears as a paper-clipped page icon.

6. To save the annotation, from the Annotations menu, click Save Annotations.

**To open files attached to a document**

*Note* You must save the file attachment annotation (see page 98) before you can open the file.

- Double-click the file attachment icon on the displayed document.
  
  The document opens in the application defined for its file type. If there is no application associated with the file type, the browser attempts to open the file itself. If it cannot, a prompt asks you to associate an application with the file.

**To delete a file attachment**

- Click the file attachment icon to select it, then press the Delete key.

**Rubber Stamp**

Rubber stamp annotations are created from a rubber stamp template list located on the VIP DocManager server. The list of available templates is created with VIP DocView. A rubber stamp template may contain up to five text fields, signatures, and a bitmap image. Rubber stamps are always displayed, whether Show Annotations is selected or not.
To place a rubber stamp

1. Select Rubber Stamp from the Annotations menu, or click the Rubber Stamp toolbar button. The Rubber Stamp dialog box opens.

![Rubber Stamp dialog box](image)

2. Click to select the template to use. Click OK.

3. In the document, drag a rectangle around the area for the stamp. This sets both the size and location of the stamp.

![Dragging a rectangle](image)

4. To save the annotation, from the Annotations menu, click Save Annotations.

To delete a rubber stamp

- Click the rubber stamp to select it, then press the Delete key.
Chapter 9

Printing, E-mailing, and Saving Documents

You can use VIP ContentExplorer to get and communicate information stored in VIP DocManager in three ways besides simply viewing archived files:

- You can print part of a document, an entire document, or multiple documents at once.
- You can send an e-mail message with one or more documents attached to it, or with a URL the recipient can use to open a document or hit list in VIP ContentExplorer.
- You can save a document as an image file or a text file.

This chapter discusses when you can use each of these features, and how to do so.

In addition to the client e-mail functionality in ContentViewer, VIP ContentExplorer enables you to use the host e-mail service for iSeries servers. The VIP DocManager server must be configured to send e-mails from the host computer.
Enabling Printing and E-mail in Firefox

If you use VIP ContentExplorer in Firefox, you must install the vipprint plug-in to enable printing or e-mailing multiple documents. If you do not install this plug-in, when you try to print or e-mail multiple documents, it will fail, with no error message.

To install the vipprint plug-in

1. In Firefox, from the Tools menu, click Options.
2. Clear the Web content cache. The exact location of this option varies among Firefox versions.
   Note Depending on how much information is in the cache, this may take several minutes.
3. Click OK to close the Options window. If it is not already open, start VIP ContentExplorer and log in to a VIP DocManager server.
4. Open any document in the VIP ContentExplorer viewer.
5. From the Help menu, select Update OpenText Print/Email Extension for Firefox.
6. If you receive a message saying Firefox has blocked the site from installing software, click Allow.
7. When the Software Installation dialog box appears, click Install Now.
8. When asked to, restart Firefox.
9. When Firefox restarts, it re-opens the VIP ContentExplorer window and viewer window, but the connection to the VIP DocManager server is not restored. Close and re-open Firefox again, then restart VIP ContentExplorer. All print and e-mail features should now work.

Tip If you have an older version of the vipprint plug-in, you will need to remove it before you can install the new version.
Printing Documents

VIP ContentExplorer includes two document printing features. You can either:

- Print all or part of a document you have open in the ContentViewer. You can print the document either with or without annotations.
- Print all of one or more documents you select from a hit list.

To print all or part of the open document

1. Open the document you want to print, using a DocFolder, DocLink, or OmniLink. See page 24, page 27, or page 38.
2. If you want to include annotations in the printed copy, make sure Show Annotations is selected on the Annotations menu (see the note at the end of this procedure).
3. Click the Print button, or, from the File menu, select Print. This opens the Print Options dialog box.

![Print Options dialog box]

Note The Auto Portrait/Landscape option appears only for images, not reports.

4. In Page Range, choose whether to print the current page, all pages, or a page range. If you select Range, type the first and last pages in the range.
5. In Select Printer, select the printer to print to.
6. In Media Size, select the paper size.
7. If you are using a duplex printer, select the desired Page Side Option: print on either one side or both sides of the paper.

Tip For some older duplex printers, to print on both sides of the paper the printer must also be set to duplex printing in the printer definition. You may be able
Printing, E-mailing, and Saving Documents

to do this using the Windows Printer dialog or, for networked printers, a network administrator may need to do it.

8. In **Page Scale Options**, select whether to fit the document to the selected paper size, or print it using its original dimensions.

   **Note**  For reports, the option to use the original document dimensions is **Use Print Parameters from Host**. If you’re printing an image, the choice is **Print Actual Size**, as shown.

9. In **Page Orientation**, choose **Portrait** or **Landscape**. For images, you can also choose **Auto Portrait/Landscape**, and VIP ContentExplorer will select the orientation for each page based on the image dimensions.

10. Click **Print** to print the document.

   **Note**  Annotations are printed only if the destination printer can print graphics. The various types of annotations are handled differently during printing:

   - Rubber stamps and blackout annotations are always printed, whether annotations are displayed or not.
   - Other annotations are printed only if annotations are displayed. File attachments and closed sticky notes are printed as icons.
   - For open sticky notes, both the note icon and the note text are printed.

**To print one or more documents from a hit list or report list**

**Note**  When you print a document from the hit list, what happens depends on the type of document it is. If it is a report or image type that can be opened in the ContentView, VIP ContentExplorer prints it. If it is a document type that cannot be opened in the ContentView, such as a Microsoft Word document, VIP ContentExplorer opens the application for it and prints it to the selected printer.

1. Using a DocLink or OmniLink, display a hit list that includes the document(s) you want to print. See page 27 or page 38.

2. On the hit list, select the documents to print.

3. On the toolbar, click the **Print Selected Docs** button. VIP ContentExplorer searches your network for your defined printers; if one or more printers is defined but not available, this may take up to a minute.
4. The *Print Options* dialog box displays.

![Print Options dialog box]

5. **Page Range** is set to All. You cannot print just part of documents using this method.

6. In **Select Printer**, select the printer to print to.

7. In **Media Size**, select the paper size.

8. If you are using a duplex printer, select the desired **Page Side Option**: print on either one side or both sides of the paper. If you choose both sides, each new document will start on a new piece of paper.

   **Tip** For some older duplex printers, to print on both sides of the paper the printer must also be set to duplex printing in the printer definition. You may be able to do this using the Windows *Printer* dialog or, for networked printers, a network administrator may need to do it.

9. In **Page Scale Options**, select whether to fit the document to the selected paper size, or print it using its original dimensions.

   **Note** For reports, the option to use the original document dimensions is **Use Print Parameters from Host**. For images, the choice is **Print Actual Size**, as shown.

10. In **Page Orientation**, choose **Portrait** or **Landscape**. For images, you can also choose **Auto Portrait/Landscape**, and VIP ContentExplorer will select the orientation for each page based on the image dimensions.

11. Click **Print** to print the documents.

   **Note** Annotations and form overlays are included in the printed documents. File attachments are printed as icons. For sticky notes, both the note icon and the note text are printed.

   Annotations are printed only if the destination printer can print graphics. If you try to print a document with critical annotations to a printer that cannot print graphics, it will fail.
E-mail Features

With VIP ContentExplorer, you can e-mail:

- all or part of a document that is open in the ContentViewer
- one or more documents selected in a hit list, either with or without annotations
- a URL to a document or hit list
- an AFP report as a PDF or text file through the iSeries host

The following sections describe each of these features.

E-mailing Documents

You can e-mail part of a document, a single document, or multiple documents. To e-mail part of a document, you must have it open in the ContentViewer. You can e-mail a single document from either a hit list or the document viewer, or multiple documents from a hit list.

In both the ContentViewer and from hit lists, there are two e-mail options: e-mail without annotations or with annotations. For documents that do not have annotations, you should generally use the e-mail without annotations feature. This attaches the document(s) to the e-mail message in their native file format. When you use the e-mail with annotations feature, VIP ContentExplorer converts the document into an image file (you can select the file format) before attaching it. This has two affects: it can make the attached file much larger than the original, and because the entire file is now an image, not text, you will not be able to search for any text inside the file.

You should use e-mail with annotations only in three cases:

- If the document has critical annotations. If a document has critical annotations, you must use the e-mail with annotations feature; you cannot send it without the critical annotations.
- If it important for the recipient to see non-critical annotations.
- If you need to send just some pages of a document. When e-mailing with annotations, you can select the pages to send. When e-mailing without annotations, you must send the entire document.

When e-mailing documents, you can use your default e-mail client—for example, Microsoft Outlook or Lotus Notes—or, if your administrator has enabled it, you can send the message directly to the SMTP server.

To e-mail all or part of a document from the ContentViewer

1. Open the document you want to send, using a DocFolder, DocLink, or OmniLink. See page 24, page 27, or page 38.

2. If you want to include non-critical annotations in the e-mailed file, make sure Show Annotations is selected on the Annotations menu (see the note at the end of this procedure).
3. Do one of the following:
   - From the File menu, select **Send without annotations**. Skip to step 7.
   - If you need to include annotations or select the pages to send, click the **Send** button or, from the File menu, select **Send**.

4. If an administrator has configured e-mailing directly through the SMTP server, the **Select Mail Service** dialog box appears. Select whether to use your e-mail client or send the message directly to the SMTP server and click **OK**.

5. If you are e-mailing with annotations, the **Email Page Chooser** dialog box appears.

   Select the page range to include in the attachment.
   - **All**—E-mails the entire document.
   - **Current Page**—E-mails the page currently displayed.
   - **Pages**—Type the specific pages to e-mail. Type a range of pages separated by a hyphen, such as 1-3, or a list of pages separated by commas, such as 1,3,5.

6. Select the format for the attached file: monochrome TIFF, color TIFF, TIFF with VIP ContentExplorer determining the color type, or PDF. Click **OK**.
7. If you are using your e-mail client, send the e-mail as you would any other. 

If you are sending directly to the SMTP server, the SMTP Mailer dialog box displays:

8. Fill in the From and To fields. If you are sending to multiple addresses, separate them with commas. Complete the other fields as desired.

9. Click Submit.

**Note** The various types of annotations are handled differently when sending a document using e-mail with annotations:

- Rubber stamps and blackout annotations are always included, whether annotations are displayed or not.
- Highlight and sticky note annotations are included only if annotations are displayed. Open sticky notes include both the sticky note and text; closed sticky notes are not shown.
- File attachments are not included.

**To e-mail one or more documents from a hit list**

1. Display a DocFolder report list, or DocLink or OmniLink hit list, that includes the document(s) you want to send. See page 24, page 27, or page 38.

2. In the list, select the documents to send.

3. Do one of the following:

   - If none of the documents has annotations, or if the recipients do not need to see the annotations, click the Email Selected Docs Without Annotations button.

   - If one or more of the documents has annotations, click the Email Selected Docs With Annotations button. This works only for file types which can be displayed in the ContentViewer.
In either case, the Print/Email Manager window opens showing the first page of the first selected document so you can confirm you’ve chosen the correct document.

**Tip**  
As explained above, e-mailing without annotations creates smaller files to attach to the e-mail message. Use e-mail with annotations only when you want the recipients to see the annotations or if there are critical annotations.

4. If an administrator has configured e-mailing directly through the SMTP server, the Select Mail Service dialog box appears. Select whether to use your e-mail client or send the message directly to the SMTP server and click OK.

5. If you are sending with annotations, the E-mail Page Chooser dialog box displays.

You cannot select a page range—you must send the entire document(s). Select the format for the attached file: monochrome TIFF, color TIFF, TIFF with VIP ContentExplorer determining the color type, or PDF. Click OK.

**Note**  
If you are sending without annotations, this dialog box does not display. The files are attached in their original formats.

6. An e-mail message is created with the selected documents attached. If you are sending multiple documents, they are combined into one compressed file.

   If using your default e-mail client, send the e-mail as you would any other.

   If sending directly to the SMTP server, the SMTP Mailer dialog box displays. Continue as described in step 8 of the previous section.
Note When you e-mail with annotations, form overlays and most annotations are included in the attached file. Rubber stamps, blackouts, highlights, and sticky notes (with text) are shown on each page. However, file attachments are not included.

E-mailing URLs

If you want another user to look at a particular document or hit list in VIP ContentExplorer, you can generate and e-mail a URL which links directly to the document or hit list. When the recipient clicks the URL, VIP ContentExplorer opens and displays the linked information.

From a hit list display, you can generate a URL for the hit list or for one or more selected documents. From the ContentViewer, you can generate a URL for the open document.

Exactly what types of URL you can send and what the recipient can do with them depends on options set by a VIP DocManager administrator:

- The administrator can enable trusted URLs. When someone clicks a trusted URL, VIP ContentExplorer automatically logs him or her into the VIP DocManager server without requiring a user name or password. When sending a trusted URL, you can restrict the user to viewing only the document or hit list the URL links to, and prevent browsing through other information, as described in the procedure below. You also select a user profile to use to determine what permissions—such as the ability to make critical annotations—the recipient will have.

If trusted URLs are disabled, all URLs require the recipient to log into the VIP DocManager server before displaying the hit list or document.

Note When the recipient uses the trusted URL, he is logged into only the VIP DocManager server, not into any associated VIP WorkflowManager server.

- The administrator can also enable or disable external URLs. An external URL enables access from anywhere on the Internet.

If external URLs are disabled, all generated URLs are usable only from within the local intranet.

Note There is a limit to the number of documents you can include in a URL attached to an e-mail message. This is a limitation of the method used to create the message automatically, and is based on the total length of the URL. Therefore, the number of documents that is allowed may vary. It is around 16 for non-trusted URLs and seven for trusted URLs. To send URLs to more documents than this, either use multiple messages or copy the URL from the dialog box where it is displayed (see step 8 in the procedure below), create the e-mail message independently, and paste the URL into the message you’ve created.
To send a URL to one or more documents or a hit list

1. Open the desired hit list—either the one to send a URL for or one containing the document(s) to send URLs for—using a DocFolder, DocLink, or OmniLink. See page 24, page 27, or page 38.

2. Do one of the following:
   - To send a URL to the hit list, click the Generate URL button.
   - To send a URL to a single document, hover the pointer in the Action column for the hit, then select Generate URL.
   - To send a URL to multiple documents, select each one, then click the Generate URL list for selected documents button.

3. If trusted URLs are not enabled for the server, the Generate URL dialog box appears. Click Show Regular Url to generate the URL. Skip to step 8.

   If trusted URLs are enabled for the server, the following dialog box is displayed:

4. To have the URL expire after a given amount of time, type the desired number in the field after Time validity for the URL and select Hours, Days, Weeks, Months, or Years.

5. To send a trusted URL, check the Is Trusted box. If you leave this box clear, the URL will require the recipient to log into the server before displaying information. If you check the box, VIP ContentExplorer generates a trusted URL and the recipient will be logged in automatically.
6. If you checked the **Is Trusted** box, either check or clear the **Restricted user** box:
   - If you check **Restricted user**, the recipient will only be able to view the document the URL points to or, for a hit list, the hit list it points to and the documents in that hit list. He or she will not be able to view other documents or run other queries to view other hit lists.
   - If you leave **Restricted user** clear, the user will be able to navigate anywhere on the VIP DocManager server, like any other user (subject to the restrictions of the user name you specify in the next step).

   **Tip** If the VIP ContentExplorer host uses SSL, you must check **Restricted user** when sending a trusted URL or it will cause an error when the user tries to use the URL.

7. Select the **Authorized trusted login profile**. This is a VIP DocManager user name. The recipient of the trusted URL will be logged in with the permissions of this user.

8. Click **Generate Url** to display the next dialog box.

   If external URLs are disabled for the server, you see one URL, as shown here:

   ![Image of generated URL]

   This is an example of a regular URL for internal users. Anyone using this URL will need a user name and password to log in.

   Here is an example of a trusted URL for internal users. Anyone using this URL will not need to log in:
If external URLs are enabled for the server, you see two URLs, one for internal (intranet) users and one for external users. This is true for both regular and trusted URLs. This screen shows regular URLs, anyone using either one will need a user name and password to log in:

9. Click the **Send as Email** button. If there are both internal and external URLs, click the button beneath the one you want to send.

10. Complete and send the e-mail. The URL is sent to the recipient. Trusted URLs will stop working after the time span set in step 4.

**Sending Reports via Host E-mail**

You can use the **Send as Host Mail** button on the DocLink hit list, or on the ContentObject list (folder view), to e-mail a copy of a report via the host e-mail application on a VIP DocManager iSeries server. You can send the report as either a PDF file or a text file.

*Note* To use this feature, SpoolMail must be installed and enabled on the VIP DocManager iSeries server.

**To select and send a report**

1. Access a DocLink or OmniLink hit list or list the reports in a Content Class. See page 24, page 27, or page 38.
2. Hover the pointer in the Action column for the desired report, then select Host Email.

![Host Email dialog box]

3. Fill in the fields on the Host Email dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>The e-mail address to send the file to.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject of the e-mail message.</td>
</tr>
<tr>
<td>Message</td>
<td>The text of the e-mail message.</td>
</tr>
<tr>
<td>Page Range</td>
<td>The part of the report to include in the attached file; type the first and</td>
</tr>
<tr>
<td></td>
<td>last page numbers. By default, this is the entire report.</td>
</tr>
<tr>
<td>Document format</td>
<td>The file format to use for the attachment. Choose either TEXT or PDF.</td>
</tr>
<tr>
<td>Note</td>
<td>The format of the original AFP file does not change. A copy of the selected</td>
</tr>
<tr>
<td></td>
<td>AFP file is converted and attached to the message.</td>
</tr>
<tr>
<td>Attachment</td>
<td>The name of the document being sent. You cannot change this.</td>
</tr>
</tbody>
</table>

4. When complete, click Send.
Saving Documents

If you want to work with a captured report or image outside VIP ContentExplorer, you can save it as either a text file or an image file. You can save reports as either text files or image files; you can save images only as image files.

Saving Reports as Text Files

When you save a report as a text file, the text in the captured report file is saved to an ASCII text file. Any non-text information in the file—such as annotations—is lost. You can save either the entire report or just selected pages.

**Note** You cannot save a report as text if it contains blackout or rubber stamp annotations. Doing so would make the text under the annotation visible.

**To save a report as a text file**

1. Open the report you want to save, using a DocFolder, DocLink, or OmniLink. See page 24, page 27, or page 38.
2. Click the **Save as Text** button or, from the File menu, select **Save as Text**. This opens the **Save as Text** dialog box.

   ![Save As Text dialog box]

3. In the **Choose location** field, specify the path and filename for the text file, or click the **Browse** button to select the path and filename. If you don’t include the `.txt` extension, VIP ContentExplorer will add it when it saves the file.
4. Select one of these options:
   - **All** — Saves the entire document.
   - **Current Page** — Saves only the current page.
   - **Pages** — To save specific pages, type a range of pages separated by a hyphen, such as `1-3`, or a list of pages separated by commas, such as `1, 3, 5`.
5. Click **OK**.
Saving Documents as Image Files

When you save a report or image as an image file, everything shown in the Content Viewer, including annotations, is included in the saved file. (Any text associated with an annotation but not shown in the Content Viewer is lost.) You can save either the entire document or just selected pages. You can also choose to save the file in PDF format or one of several versions of TIFF.

To save a document as an image file

1. Open the report or image you want to save, using a DocFolder, DocLink, or OmniLink. See page 24, page 27, or page 38.
2. From the File menu, select Save as Image. This opens the Save as Image dialog box.
3. In the Choose save file field, specify the path and filename for the file, or click the Browse button to select the path and filename.
4. In Choose the image format for saving, select the image format to use.
5. Select one of these options:
   - All — Saves the entire document.
   - Current Page — Saves only the current page.
   - Pages — To save specific pages, type a range of pages separated by a hyphen, such as 1-3, or a list of pages separated by commas, such as 1,3,5.
6. Click OK.
Chapter 10

Audit Log Viewing

VIP DocManager maintains report tables containing information about user activity with objects such as a hit list, folder, and so on. You can view much of this information in VIP ContentExplorer. A more comprehensive log (including server operations) is available on the VIP DocManager server and accessible by Administrators.
Audit Log Viewing

About the Audit Log

The following table shows the type of user activity VIP ContentExplorer logs and you can view:

<table>
<thead>
<tr>
<th>Operation Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve Object</td>
<td>Logs when a report or image is retrieved from the server for viewing by the client.</td>
</tr>
<tr>
<td>View Object</td>
<td>Log when a report or image is opened in the Content Viewer.</td>
</tr>
<tr>
<td>Print Object</td>
<td>Logs a print start event.</td>
</tr>
<tr>
<td>Send/E-mail Object</td>
<td>Logs when an e-mail was sent.</td>
</tr>
<tr>
<td>Export Object</td>
<td>Logs the saving of content.</td>
</tr>
<tr>
<td>Retrieve Link</td>
<td>Logs that a DocLink or OmniLink was retrieved from the server.</td>
</tr>
<tr>
<td>View Link</td>
<td>Logs that a DocLink or OmniLink was viewed.</td>
</tr>
<tr>
<td>Retrieve Annotation</td>
<td>Logs that a page with annotations was retrieved from the server.</td>
</tr>
<tr>
<td>View Annotation</td>
<td>Logs the viewing of a page that contains annotations.</td>
</tr>
</tbody>
</table>

The retrieve and view entries generally come in matching pairs, as they are created by the same operation: the client—that is, you using VIP ContentExplorer—displaying something stored on the VIP DocManager server: a DocLink, a report, a particular page, and so on. The retrieve entry is recorded by the VIP DocManager server, while the view entry is recorded by VIP ContentExplorer.

**Note** Logging must be enabled on the VIP DocManager server. If it is not, the Log button will not appear for hits in a hit list, and will not be active in the Content Viewer.

To view the audit log

1. Using a DocFolder, DocLink, or OmniLink, display a list of objects that includes the document you want to see the log for. See page 24, page 27, or page 38.

2. Hover the pointer in the Action column for the desired document, then select **Audit Log**. The audit log appears in the Content Frame.

**Note** You can also open the document in the Content Viewer, then click the **Show Log** button on the toolbar. If you do, the audit log opens in a separate browser window.

The audit log always shows information relating to the document you selected. It may also include your other recent activity, depending on the information provided by the VIP DocManager server.
The Audit Log Display

Each row in the log is one audit entry. Each entry may include details about the logged activity. If it does, you can expand the entry to show its details by clicking the plus sign (+) at the left of the entry, then collapse it by clicking the minus sign (-). Here is a sample audit log display, with some entries expanded:

<table>
<thead>
<tr>
<th>Date</th>
<th>Operation</th>
<th>Details</th>
<th>Comment</th>
<th>User Name</th>
<th>Page Number</th>
<th>Note Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200501017</td>
<td>Retrieve Link</td>
<td>0x41E3C000:001E</td>
<td>dmserver</td>
<td>0 0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- The first expanded entry shows details for a retrieve link operation performed by the user dmserver. It shows that this user attempted to retrieve a DocLink hit, MAGPATIMG, with index values:

```
LAST NAME=KLEIN, CATHERINE
PLANNO=738181
CLAIMTOT=57.00
```

- The next expanded entry shows a view object operation performed by the same user. The details show that this user attempted to view the same hit as in the first entry.

- The last expanded entry shows that the dmserver user attempted to read page 2 of a document.
Appendix A

Setting Java Memory Sizes

For improved VIP ContentExplorer performance, including the best quality when printing and emailing documents, you may need to increase the memory allocated for the Java Plug-in on the client workstation. This appendix describes how to set the memory allocation for the supported Java Plug-in versions that require setting the memory size on the client. As described on the next page, for later versions of the plug-in, memory settings are defined by an administrator on the VIP Content Explorer server and used by all client workstations.
Java Plug-in 1.6.x

If your workstation is running an early version of the 1.6.x JRE or JDK, follow this procedure to set the amount of memory allocated for the plug-in:

**Note**  **Important!** If you are running JRE 1.6.0_10 or later, you do not need to change the memory settings. VIP ContentExplorer will automatically use the settings from the VIP ContentExplorer server. How to define Java memory settings on the server is described in the *VIP ContentExplorer Installation and Administration Guide*.

1. From the Windows Start menu, open the Control Panel. The exact way to do this depends on the Windows version you are using.
2. On the Control Panel, double-click Java.
3. Select the Java tab.
4. In the **Java Applet Runtime Settings** section, click the **View** button.

The Java Runtime Settings window appears. Each line in the table is for a different Java Plug-in version; if you have had more than one version of the Plug-in installed, there will be more than one line with entries. In most cases, the bottom line is for the most recent, active version.

![Java Runtime Environment Settings](image)

5. In the **Runtime Parameters** field for the current version of the plug-in, type:

   `-Xmx###m  `-Xms###m`

   ### is the number of megabytes of memory to allocate to the Java Plug-in. It should be at least 128. In most cases, we recommend using 512. Do not set it higher than 768.

   **Warning**   Do not set the Java memory size equal to or higher than the physical memory in your computer, or the Java Plug-in may not be able to start.
Appendix B

Technical Support

If you need further assistance contact your authorized reseller or write to OpenText Customer Support at support@opentext.com, or telephone (800) 540-7292 or (519) 888-9933. Our support hours are Monday through Friday, 8:30 am to 8:00 pm (EST).

Please have the following information available as necessary:

- Software version
- Operating system
- Network and client configuration

If you have comments or suggestions regarding this documentation, write to the OpenText Publications Group at documentation@opentext.com.

For more information regarding OpenText products and services, visit our home page at http://www.opentext.com/.

Open Text Corporation

275 Frank Tompa Drive
Waterloo, Ontario, Canada
N2L 0A1
(519) 888-7111
Index

A

accessing your content
  overview 23
  via Content Classes 24
  via Content Objects 24
  via DocFolders 24
  via DocLinks 27
  via OmniLinks 38
Add to Favorites button 20
Admin Column Editor button 20
AFP reports
  document resolution 83
e-mailing 119
annotations
  as document revisions 64
  attach file 104
    opening the file 104
  blackout 100
    always display 96
    always print 99
    in e-mailed documents 114
    printing 110
  colors for 97
displaying 96
e-mailing 112, 114, 115, 116
going to a bookmark 80, 98
hiding 96
highlight 101
list of types 99
overview 92, 96
printing 99, 109, 110, 111
rubber stamp 104
  in e-mailed documents 114
  printing 110
saving 98
setting as bookmarks 97
setting colors 97
showing 96
sticky notes 102
Annotations menu inContentViewer 73, 96—??
attach file annotations 104
opening the file 104
Attach File button inContentViewer 77, 104
audit log 124
  list of logged actions 124
  sample 125
  viewing 124

B

background color for reports 83
blackout annotations 100
  always display 96
  always print 99
  color of 97
  creating 100
  in e-mailed documents 114
  printing 110, 111
Blackout button inContentViewer 76, 100
Bookmark button inContentViewer 77, 80
bookmarks
  creating 97
  going to 80, 98
Bottom button inContentViewer 76, 80
buttons
  Add to Favorites 20
  Admin Column Editor 20
  Capture 19, 35
  Check Error Log 20
  Clear All 19, 26
  Collapse Tree Frame 20
  Compare 19, 26, 32, 43
  ContentView, see ContentView buttons
  Display Previous Query 20
  E-mail 114
  E-mail With Annotations 19
  E-mail Without Annotations 19
  Expand Tree Frame 20
  Generate URL 20, 117
  Generate URL List 19
  Logout 20, 22
  Print 19, 110
  Refresh 20
Index

buttons, *continued*
- Save Query 20
- Search 19, 49
- Select All on Page 19
- toolbar 19
- Tree Control pane
  - Next 17
  - User Column Editor 20, 33, 48
- View 19, 26, 32, 42

C
- Cancel button for workflow 50
- canceling a check out 62, 63
- Captaris Workflow 54
- Capture button 19, 35
- capturing files via DocLinks 35
  - revision control 58
- case description for workflow 51
- case status icons
  - deadline 47
  - deadline expired 47
  - locked 47
  - new case 47
  - previously opened 47
  - urgent 47
- cases
  - opening existing 46
  - opening new 53
  - processing 52
  - searching for 49
- changing document display size 81
- changing the display language 14
- Check Error Log button 20
- checking in a document
  - initial 58
  - thorough the ContentViewer 64
  - through a hit list 62
- checking out a document
  - canceling 62, 63
  - from a hit list 59
  - from the ContentViewer 64
  - lock type 60
  - preventing 67
- Clear All button 19, 26
- closing VIP ContentExplorer 22
- Collapse Tree Frame button 20
- colors
  - annotations 97
- reports
  - background 83
  - green or blue bars 83
  - text 83
  - selecting for e-mailed documents 113, 115
- columns
  - defining for workflow items 47, 48
  - defining in hit list 31, 33, 42
  - sorting 31, 33, 42, 47, 48
- comments for revisions tips 57
- comments for workflow 51
- Compare button 19, 26, 32, 43
- comparing documents 26, 32, 43, 78
- contacting Open Text 131
- content
  - capturing via DocLinks 35
  - revision control 58
- Content Classes
  - accessing 24
  - description 16
  - opening 24
- Content Frame
  - defining columns for workflow items 48
  - defining columns in hit list 33
    - User Column Editor 33, 48
- Content Objects
  - opening 24
  - overview 24
- ContentView
  - AFP document resolution 83
  - annotations 96–??
    - see also annotations
  - annotations and revision control 64
- buttons
  - Attach File 77, 104
  - Blackout 76, 100
  - Bookmark 77, 80
  - Bottom (last page) 76, 80
  - External Viewer 77
  - Fit to Height 76, 81
  - Fit to Page 76, 81
  - Fit to Width 76, 81
  - Generate URL 77, 117
  - GoTo 76, 80
  - Highlight 77, 101
  - Next Page 76, 80
  - Previous Page 76, 80
  - Print 75, 109
**ContentViewer, continued**

<table>
<thead>
<tr>
<th>Buttons, continued</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate Clockwise</td>
<td>76, 82</td>
</tr>
<tr>
<td>Rotate Counter Clockwise</td>
<td>76, 82</td>
</tr>
<tr>
<td>Rubber Stamp</td>
<td>77, 105</td>
</tr>
<tr>
<td>Save as Text</td>
<td>75, 121</td>
</tr>
<tr>
<td>Send</td>
<td>76, 113</td>
</tr>
<tr>
<td>Show Annotations</td>
<td>76, 96</td>
</tr>
<tr>
<td>Show Log</td>
<td>77, 124</td>
</tr>
<tr>
<td>Sticky Note</td>
<td>77, 103</td>
</tr>
<tr>
<td>Top (first page)</td>
<td>76, 80</td>
</tr>
<tr>
<td>Work with Page Notes</td>
<td>76, 93</td>
</tr>
<tr>
<td>Zoom In</td>
<td>76, 81</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>76</td>
</tr>
<tr>
<td>Checking documents in and out</td>
<td>64</td>
</tr>
<tr>
<td>Comparing documents</td>
<td>78</td>
</tr>
<tr>
<td>For workflow items</td>
<td>50</td>
</tr>
<tr>
<td>Image processing</td>
<td>83</td>
</tr>
<tr>
<td>Menus</td>
<td>72</td>
</tr>
<tr>
<td>Annotations</td>
<td>73, 96--97</td>
</tr>
<tr>
<td>File</td>
<td>72, 109--122</td>
</tr>
<tr>
<td>GoTo</td>
<td>72, 80</td>
</tr>
<tr>
<td>Help</td>
<td>75</td>
</tr>
<tr>
<td>Notes</td>
<td>73, 93</td>
</tr>
<tr>
<td>Options</td>
<td>75, 83</td>
</tr>
<tr>
<td>Search</td>
<td>75, 88</td>
</tr>
<tr>
<td>View</td>
<td>81</td>
</tr>
<tr>
<td>Images</td>
<td>74</td>
</tr>
<tr>
<td>Moving through documents</td>
<td>80</td>
</tr>
<tr>
<td>Overview</td>
<td>69, 70</td>
</tr>
<tr>
<td>Rotating images</td>
<td>82</td>
</tr>
<tr>
<td>Sample display</td>
<td>71</td>
</tr>
<tr>
<td>Searching report indices</td>
<td>88</td>
</tr>
<tr>
<td>Searching report text</td>
<td>86</td>
</tr>
<tr>
<td>Setting colors for reports</td>
<td>83</td>
</tr>
<tr>
<td>Supported file formats</td>
<td>70</td>
</tr>
<tr>
<td>Text notes</td>
<td>93</td>
</tr>
<tr>
<td>Text vs. images</td>
<td>72</td>
</tr>
<tr>
<td>Toolbar</td>
<td>75</td>
</tr>
<tr>
<td>Workspace</td>
<td>71</td>
</tr>
<tr>
<td>Copying DocLink values</td>
<td>36</td>
</tr>
<tr>
<td>Creating bookmarks</td>
<td>97</td>
</tr>
<tr>
<td>Creating text notes</td>
<td>93</td>
</tr>
<tr>
<td>Creating workflow case</td>
<td>53</td>
</tr>
<tr>
<td>Customer support</td>
<td>131</td>
</tr>
</tbody>
</table>

**D**

<table>
<thead>
<tr>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defining bookmarks</td>
<td>97</td>
</tr>
<tr>
<td>Deleting annotations</td>
<td>98</td>
</tr>
<tr>
<td>Deleting DocLink values</td>
<td>37</td>
</tr>
<tr>
<td>Deleting highlight annotations</td>
<td>102</td>
</tr>
<tr>
<td>Deleting sticky notes</td>
<td>103</td>
</tr>
<tr>
<td>Deleting text notes</td>
<td>93</td>
</tr>
<tr>
<td>Deskewing an image</td>
<td>83</td>
</tr>
<tr>
<td>Despeckling an image</td>
<td>83</td>
</tr>
<tr>
<td>Displaying annotations</td>
<td>96</td>
</tr>
<tr>
<td>Displaying documents in ContentViewer</td>
<td>70</td>
</tr>
<tr>
<td>DocFolders</td>
<td>24</td>
</tr>
<tr>
<td>Accessing revision control</td>
<td>58</td>
</tr>
<tr>
<td>Checking in a document</td>
<td>62</td>
</tr>
<tr>
<td>Checking out a document</td>
<td>59</td>
</tr>
<tr>
<td>Concept</td>
<td>27</td>
</tr>
<tr>
<td>Copying values</td>
<td>36</td>
</tr>
<tr>
<td>Deleting values</td>
<td>37</td>
</tr>
<tr>
<td>Description</td>
<td>16</td>
</tr>
<tr>
<td>Example</td>
<td>28</td>
</tr>
<tr>
<td>Modifying values</td>
<td>36</td>
</tr>
<tr>
<td>Opening documents through</td>
<td>28</td>
</tr>
<tr>
<td>Offline</td>
<td>30</td>
</tr>
<tr>
<td>Overview</td>
<td>27</td>
</tr>
<tr>
<td>Protecting documents</td>
<td>67</td>
</tr>
<tr>
<td>Saving queries</td>
<td>32</td>
</tr>
<tr>
<td>Document revisions</td>
<td>62, 63</td>
</tr>
<tr>
<td>Cancelling a check out</td>
<td>62, 64</td>
</tr>
<tr>
<td>Check in</td>
<td>62, 64</td>
</tr>
<tr>
<td>Check out</td>
<td>59, 64</td>
</tr>
<tr>
<td>Comments tips</td>
<td>57</td>
</tr>
<tr>
<td>Index values tips</td>
<td>57</td>
</tr>
<tr>
<td>Initial check in</td>
<td>58</td>
</tr>
<tr>
<td>Modifying a document</td>
<td>61</td>
</tr>
<tr>
<td>Overview</td>
<td>56</td>
</tr>
<tr>
<td>Process overview</td>
<td>56</td>
</tr>
<tr>
<td>Tips</td>
<td>57</td>
</tr>
</tbody>
</table>
documents
  adding text notes 93
  annotations to 96
  canceling a check out 62, 63
  comparing 78
  displaying for workflow item 52
  e-mailing 112
  opening via DocFolders 24
  opening via DocLinks 28
  opening via OmniLinks 39
  protecting 67
  reverting revisions 66
  saving
    as image files 122
    as text files 121
    overview 121
  viewing
    moving around 80
    zooming 81
  Done button for workflow 51
dynamic forms
  Action field 51
  Cancel button 50
  case description 51
  comments 51
  Done button 51
  form fields 51
  overview 50
  Refresh button 51
  Save button 51
  step description and ID 51
  Views field 51
trusted URLs 116
  emailing
    plug-in for Firefox 108
  enlarging displayed documents 81
  exiting VIP ContentExplorer 22
  Expand Tree Frame button 20
  external URLs 116
  sample 119
  External Viewer button in ContentViewer 77
F
  File menu in ContentViewer 72, 109–122
files
  capturing via DocLinks 35
  revision control 58
  formats displayed in ContentViewer 70
  formats for e-mail attachments 113, 115
  Firefox plug-in for print and e-mail 108
  Fit to Height button in ContentViewer 76, 81
  Fit to Page button in ContentViewer 76, 81
  Fit to Width button in ContentViewer 76, 81
  form fields for workflow 51
G
  Generate URL button 20, 117
  Generate URL button in ContentViewer 77, 117
  Generate URL List button 19
  going to a bookmark 80, 98
  GoTo button in ContentViewer 76, 80
  GoTo menu in ContentViewer 72, 80
H
  head revision 66
  Help link 20
  Help menu in ContentViewer 75
  hiding annotations 96
  highlight annotations 101
    color of 97
    creating 101
    deleting 102
  Highlight button in ContentViewer 77, 101
  hit list
    e-mailing from 114
    e-mailing URL to 116
    printing from 110
Index

I

icons, see buttons 122
image files, creating from documents 122
images
  adding text notes 93
  annotations to 96
  capturing via DocLinks 35
    revision control 58
  comparing 78
  deskeewing 83
  despckling 83
  displaying for workflow item 52
  e-mailing 112
  opening via DocLinks 28
  opening via OmniLinks 39
  processing 83
  revision control 56
  rotating 82
  saving
    as image files 122
    overview 121
  viewing
    moving around 80
    zooming 81
index values
  changing for a revision 57
  copying 36
  deleting 37
  modifying 36
tips for revision control 57
initial check in for revision control 58
iSeries reports, searching indices 88
items (workflow)
  dynamic forms window 50
    Cancel button 50
    Done button 51
    form fields 51
    Refresh button 51
    Save button 51
    Views field 51
  opening
    overview 46
    processing 4

J

Java memory sizes 127
  setting for JDK 1.5.x or 1.6.x 128

L

language, changing 14
lock type for revision control 60
locking documents 67
logging in 12
  user names and passwords 12
logging out 22
Logout button 20, 22

M

magnification of document display 81
modifying a document under revision control 61
moving through documents in ContentViewer 80
moving to a bookmark 80, 98

N

navigation buttons 17
Next button in Tree Control pane 17
Next Page button in ContentViewer 76, 80
notes 92, 93
Notes menu in ContentViewer 73, 93

O

offline DocLinks, searching 30
OmniLinks
  checking in a document 62
  checking out a document 59
description 16
example 38
opening documents through
  overview 38
  protecting documents 67
  saving queries 32
Online help 20
opening
  documents 24–43
  new workflow case 53
  revision control documents 61
  workflow items 46
OpenText Workflow Server 54
operating requirements 7
Options menu in ContentViewer 75, 83
overview of VIP ContentExplorer 3
Index

P

page orientation, changing 82
page, changing in ContentViewer 80
passwords 12
Position to input field in Tree Control pane 18
Previous Page button in ContentViewer 76, 80
Print button 19, 110
Print button in ContentViewer 75, 109
printing
   annotations 99, 110, 111
   closed documents 110
   from a hit list 110
   including annotations 109
   multiple documents 110
   open document 109
   plug-in for Firefox 108
procedures (workflow) 4
description 17
processing images 83
processing workflow items 52
protecting documents 67

R

Refresh button 20
Refresh button for workflow 51
report distribution segments 24
reports
   adding text notes 93
AFP
document resolution 83
e-mailing 119
annotations to 96
comparing 78
displaying for workflow item 52
e-mailing 112
indices, searching 88
opening via DocFolders 24
opening via DocLinks 28
opening via OmniLinks 39
sample ContentViewer display 71
saving
   as image files 122
   as text files 121
   overview 121
searching text 86
setting AFP document resolution 83
setting colors 83
   viewing 70
   moving around 80
   zooming 81
resolution for AFP documents 83
reverting a document 66
revision control
   annotations as revisions 64
   canceling a check out 62, 63
   checking in a document 62, 64
   checking out a document 59, 64
   comment tips 57
   entering comments 57
   entering new index values 57
   head revision 66
   index values tips 57
   initial check in 58
   lock type 60
   modifying a document 61
   overview 55, 56
   process overview 56
   protecting documents 67
   reverting documents 66
   tips 57
   viewing older revisions 65
Rotate Clockwise button in ContentViewer 76, 82
Rotate Counter Clockwise button in ContentViewer 76, 82
rotating images in the ContentViewer 82
Rubber Stamp button in ContentViewer 77, 105
rubber stamps 104
   in e-mailed documents 114
   printing 110, 111
rubberband zooming 81

S

Save as Text button in ContentViewer 75, 121
Save button for workflow 51
Save Query button 20
saving
   annotations 98
documents
   as image files 122
   overview 121
   reports as text files 121
queries 32
Search button 19, 49
Search menu in ContentViewer 75, 88
searching report indices 88
searching report text 86
security 5
segments, viewing 24
Select All on Page button 19
selecting colors for annotations 97
selecting the language for the display 14
Send button in ContentViewer 76, 113
sequential search 86
setting
  colors for annotations 97
  report colors 83
Show Annotations button in ContentViewer 76, 96
Show Log button in ContentViewer 77, 124
showing annotations 96
SMTP server, using for e-mail 112, 114
sorting columns 31, 33, 42, 47, 48
starting a new workflow case 53
step description and ID for workflow 51
steps (workflow)
  opening 46
  processing 52
Sticky Note button in ContentViewer 77, 103
sticky notes 102
color of 97
deleting 103
support 131

t
  technical support 131
text
  blackout 100
  highlighting 101
text color for reports 83
text files, creating from reports 121
text notes 92
text reports, converted to PDF 72
toolbar buttons 19
Top button in ContentViewer 76, 80
Tree Control pane
  navigating 17
Next button 17
Position to input field 18
trusted URLs 116
generating 117

sample 118

U

URLs
  e-mailing 116
  external 116
    sample 119
  trusted 116
    generating 117
    sample 118
User Column Editor 33, 48
User Column Editor button 20, 33, 48
user interface, see workspace
user names for VIP ContentExplorer 12

V

View button 19, 26, 32, 42
View menu in ContentViewer 74, 81
viewing
  audit log 124
  documents 80
    moving around 80
  zooming 81
  segments 24
text notes 93
Views field for workflow 51
VIP ContentExplorer
  features 5
  manual, organization 2
  operating requirements 7
  overview 3
VIP ContentViewer, see ContentViewer
VIP DocManager server, logging in 12
VIP WorkflowManager server, logging in 12

W

work queues 4
description 17
searching 49
Work with Page Notes button in ContentViewer 76, 93
Index

<table>
<thead>
<tr>
<th>wageflow items</th>
<th>Workflow Server</th>
<th>54</th>
</tr>
</thead>
<tbody>
<tr>
<td>defining columns for</td>
<td>workspace</td>
<td></td>
</tr>
<tr>
<td>dynamic form window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Done button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>form fields</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Refresh button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Views field</td>
<td></td>
<td></td>
</tr>
<tr>
<td>opening</td>
<td></td>
<td></td>
</tr>
<tr>
<td>overview</td>
<td></td>
<td></td>
</tr>
<tr>
<td>processing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>searching for</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Z                                           |                  |    |
|                                             |                  |    |
| Zoom In button inContentViewer              |                  |    |
| Zoom Out button inContentViewer             |                  |    |
| zooming document display                   |                  |    |

| 47, 48                                      |                  |    |
| 50                                          |                  |    |
| 51                                          |                  |    |
| 51                                          |                  |    |
| 51                                          |                  |    |
| 51                                          |                  |    |
| 46                                          |                  |    |
| 4                                           |                  |    |
| 52                                          |                  |    |
| 49                                          |                  |    |
| 18                                          |                  |    |
| 15                                          |                  |    |
| 14                                          |                  |    |
| 19                                          |                  |    |
| 15                                          |                  |    |

| Content Frame                              |                  |    |
| overview                                   |                  |    |
| selecting display language                |                  |    |
| toolbar buttons                            |                  |    |
| Tree Control pane                          |                  |    |

| 76, 81                                      |                  |    |
| 76                                          |                  |    |
| 81                                          |                  |    |

VIP Content Explorer User's Guide